ARLINGTON COUNTY, VIRGINIA
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ARLINGTON COUNTY, VIRGINIA
OFFICE OF THE PURCHASING AGENT
SUITE 500, 2100 CLARENDON BOULEVARD
ARLINGTON, VA 22201

AGREEMENT NO. 17-165-RFP

THIS AGREEMENT is made, on the date of execution by the County, between Welligent, 5205 Colley
Avenue, Norfolk, Virginia, 23508 (“Contractor”) a Virginia corporation authorized to do business in the
Commonwealth of Virginia, and the County Board of Arlingten County, Virginia (“County”). The County
and the Contractor, for the consideration hereinafter specified, agree as follows:

1. CONTRACT DOCUMENTS
The “Contract Documents” consist of:

This Agreement

Attachment A — Scope of Work

Attachment B = Contract Pricing

Attachment C — Business Associate Agreement

Attachment D — County Nondisclosure and Data Security Agreement (Contractor)

Attachment E = Definitions

Attachment F — License Grant

Attachment G — implementation Plan and Personnel

Attachment H — Support Policies and SLA

Attachment | — Minimum Technical Environment

Attachment ) — Scope Change Procedure

Attachment K — Source Code Escrow Agreement

Attachment L — List of Forms (referenced by Attachment A)

Attachment M — Images of Forms (referenced by Attachment A)

Attachment N - Data Conversion (referenced by Attachment A)

Attachment O — Billing Setup {referenced by Attachment A)

Attachment P — Functionality Matrix and Interfaces (referenced by Attachment A)

Attachment Q — Project Resources (referenced by Attachment G)

Attachment R ~ Contractor Response to Request for Proposal 17-165-RFP
Marked Proprietary by Contractor and removed: Pages 13-14, 29-30, 39, 46-48, 53,
59, 60, 64, 66, 69, 76, 78, 80, 81, 83, 85, 87, 91, 106-141, 147-148.

Attachment S — Request for Proposal 17-165-RFP Solicitation

Attachment T - Arlington County Community Services Board Program Descriptions

Where the terms and provisions of this Agreement vary from the terms and provisions of the other
Contract Documents, the terms and provisions of this Agreement will prevail over the other Contract
Documents, and the remaining Contract Documents will be complementary to each other. If there are
any conflicts, the most stringent terms or provisions will prevail.

The Contract Documents set forth the entire agreement between the County and the Contractor. The
County and the Contractor agree that no representative or agent of either party has made any
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2. SCOPE OF WORK

The Contractor agrees to perform the services described in the Contract Documents {the “Work"). As
detailed in the “Scope of Work” (Attachment A), the primary purpose of the Work is an Electronic Health
Record System for the Department of Human Services. It will be the Contractor's responsibility, at its sole
cost, to provide the specific services set forth in the Contract Documents and sufficient services to fulfill
the purposes of the Work. Nothing in the Contract Documents limits the Contractor's responsibility to
manage the details and execution of the Work.

3. PROJECT OFFICER

The performance of the Contractor is subject to the review and approval of the County Project Officer,
who will be appointed by the Director of the Arlington County department or agency requesting the Work
under this Contract.

4, CONTRACT TERM

Time is of the essence. The Work will commence on the date of the execution of the Agreement by the
County and must be completed no later than December 31, 2022 ("initial Contract Term"), subject to any
modifications provided in the Contract Documents. Upon satisfactory performance by the Contractor the
County may, through issuance of a unilateral Notice of Award, authorize continuation of the Agreement
under the same contract prices for not more than five {5) additional 12-month periods, from January 1st,
2023 to December 31st, 2027 (each a "Subsequent Contract Term"). The Initial Contract Term and any
Subsequent Contract Term(s) are together the “Contract Term”.

5. CONTRACT AMOUNT

The County will pay the Contractor in accordance with the terms of the Payment section below and of
Attachment B for the Contractor's completion of the Work as required by the Contract Documents. The
Contractor will complete the Work for the total amount specified in this section {“Contract Amount”).

The County will not compensate the Contractor for any goods or services beyond those included in
Attachment A unless those additional goods or services are covered by a fully executed amendment to
this Contract. Additional services will be billed at the rates set forth in Attachment 8 unless otherwise
agreed by the parties in writing.

6. CONTRACT PRICE ADJUSTMENTS

The Contract Amount/unit price(s) will remain firm until December 31%, 2021 (“Price Adjustment Date”).
To request a price adjustment, the Contractor or the County must submit a written request to the other
party not less than 60 days before the Price Adjustment Date. Adjustments to the Contract Amount/unit
price(s) will not exceed the percentage of change in the U.S. Department of Labor Consumer Price Index,
All ltems, Unadjusted, Urban Areas (“CPI-U") for the 12-month period ending in October of each year of
the Contract.

Any Contract Amount/unit price(s) that result from this provision will become effective the day after the
Price Adjustment Date and will be binding for 12 months. The new Price Adjustment Date will be 12
months after the price adjustment.
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If the Contractor and the County have not agreed on a requested adjustment by 30 days before the Price
Adjustment Date, the County may terminate the Contract, whether or not the County has previously
elected to extend the Contract’s term.

7. PAYMENT

The Contractor must submit invoices to the County’s Project Officer according to the payment milestones
in Attachment B — Contract Pricing. The Project Officer will either approve the invoice or require
corrections. The County will pay the Contractor within 30 days after receipt of an approved invoice for
completed work that is reasonable and allocable to the Contract and that has been performed to the
satisfaction of the Project Officer. The number of the County Purchase Order pursuant to which goods or
services have been delivered or performed must appear on all invoices.

If the County makes a partial payment, it will retain 5% of the estimate upon which the partial payment is
based until completion and final acceptance of the Work.

8. TAXES

The amounts payable to the Contractor as specified herein are payable in full to the Contractor without
deduction, but shall be deemed inclusive of any and all applicable taxes or assessments, including,
without limitation, any sales, use, privilege, ad valorem, excise and other taxes or assessments
(colliectively, the “Taxes”), that may be due, levied, or based as a result of any and all services provided or
products sold under this Agreement. County represents it is a tax-exempt entity. The Contractor shall be
solely obligated to pay all of the Taxes, whether or not specifically invoiced to and collected from the
County.

The Contractor agrees to defend, indemnify, and hold harmless the County and all of the County’s
officers, directors, employees, and agents from and against any liability, responsibility, charge, claim, loss,
payment, damage, cost, or expense (including, without limitation attorneys’ fees and court costs)
incurred as a result of any: (a) Taxes paid by, charged to, or assessed against any such indemnified party;
or (b) any Taxes due or alleged due to any entity from the County as a result of any services or products
provided, purchased, licensed, or used by the County under this Agreement. Further, the Contractor shall
reimburse the County immediately in the event of payment of any Taxes by the County.

9. REIMBURSABLE EXPENSES

The County will not reimburse the Contractor for any expenses under this Contract that are not travel-
related expenses. The amount in Attachment B includes all costs and expenses of providing the services
described in this Contract.

10. REIMBURSABLE TRAVEL-RELATED EXPENSES

The County will not reimburse the Contractor for travel-related expenses for employees located within
the greater Baltimore-Washington Metropolitan Area, as defined by the United States Office of
Management and Budget. For employees located outside this area, the County will reimburse for pre-
approved travel-related expenses, documented with receipts, as follows:

Meals: The County will reimburse at the U.S. General Services Administration’s (“GSA”) per diem rates for
the destination, current for the date of travel, with the first and last days of travel counted at 75% of the
per diem rate.

Lodging: The County will reimburse for actual lodging costs at a reasonably priced commercial facility in
the immediate area of where the Work is performed, up to the GSA’s daily rates for the destination,
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current for the date of travel. Receipts for lodging must be itemized. Only room and tax charges will be
reimbursed; no reimbursement will be made for additional expenses, including but not limited to, room
service, laundry, telephone and in-room movies. If the Contractor or its employee shares a room with
another person who is not connected with the performance of the Work, including a spouse, the County
will reimburse for only the cost of a single room.

The applicable GSA per diem rates can be obtained at http://www.gsa.gov/portal/content/104877.

Transportation:

General
Reservations must be made in advance whenever possible to take advantage of all available
discounts.

Ground Transportation

Use of public transportation is encouraged. The County will reimburse for the business use of
personal or company vehicles, if allowed, at the GSA's mileage rates current at the time of travel. The
Contractor’s request for reimbursement may not include any personal use of the vehicle.

The County may approve reimbursement for rental of vehicles or use of taxicabs if the Contractor can
demonstrate that to be the most economical option. Any reimbursement will cover only those rental
charges, insurance and/or fuel fees allocable to work on the Contract and will not cover the purchase
of liability insurance and/or collision/comprehensive insurance if the Contractor’s or the employee’s
existing insurance coverage provides such protection.

Air Travel
The County will reimburse for air travel at the lowest available fare, typically economy. Tickets must
be purchased at least seven days in advance, unless otherwise approved by the County.

Time limit: The County will not honor requests for travel reimbursement that are submitted more than 60
days after completion of the travel.

Non-reimbursable Expenses: The County will never reimburse for the following expenses:

11,

Alcoholic beverages

Personal phone calls

Entertainment (e.g. pay TV, movies, night clubs, health clubs, theaters, bowling)

Personal expenses (e.g. laundry, valet, haircuts)

Personal travel insurance (e.g. life, medical, or property insurance) for airfare or rental cars
Auto repairs, maintenance and insurance costs for personal vehicles

R e ol

*PAYMENT OF SUBCONTRACTORS

The Contractor is obligated to take one of the two following actions within seven days after receipt of
payment by the County for work performed by any subcontractor under this Contract:

a.

Pay the subcontractor for the proportionate share of the total payment received from the County
attributable to the work performed by the subcontractor under this Contract; or
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b. Notify the County and the subcontractor, in writing, of the Contractor's intention to withhold all
or a part of the subcontractor's payment, with the reason for nonpayment.

The Contractor is obligated to pay interest to the subcontractor on all amounts owed by the Contractor to
the subcontractor that remain unpaid after seven days following receipt by the Contractor of payment
from the County for work performed by the subcontractor under this Contract, except for amounts
withheld as allowed in subsection b., above. Unless otherwise provided under the terms of this Contract,
interest will accrue at the rate of 1% per month.

The Contractor must include in each of its subcontracts, if any are permitted, a provision requiring each
subcontractor to include or otherwise be subject to the same payment and interest requirements with
respect to each lower-tier subcontractor.

The Contractor's obligation to pay an interest charge to a subcontractor pursuant to this section may not
be construed to be an obligation of the County. A Contract modification may not be made for the
purpose of providing reimbursement for such interest charge. A cost reimbursement claim may not
include any amount for reimbursement for such interest charge.

12. NO WAIVER OF RIGHTS
The County’s approval or acceptance of or payment for any goods or services under this Contract will not
waive any rights or causes of action arising out of the Contract.

13. *NON-APPROPRIATION

All payments by the County to the Contractor pursuant to this Contract are subject to the availability of
an annual appropriation for this purpose by the County Board of Arlington County, Virginia {“Board”). In
the event the Board does not appropriate funds for the goods or services provided under this Contract,
the County will terminate the Contract, without termination charge or other liability to the County, on the
last day of the fiscal year or when the previous appropriation has been spent, whichever event occurs
first.

14. *COUNTY PURCHASE ORDER REQUIREMENT

County purchases are authorized only if the County issues a Purchase Order in advance of the transaction,
indicating that the ordering County agency has sufficient funds available to pay for the purchase. If the
Contractor provides goods or services without a signed County Purchase Order, it does so at its own risk
and expense, The County will not be liable for payment for any purchases made by its employees that are
not authorized by the County Purchasing Agent.

15. BACKGROUND CHECK

All employees or subcontractors whom the Contractor assigns to work on this Contract from an Arlington
County Government office, including maintenance and support, must pass a background and Virginia
Department of Social Services’ Central Registry check. Contractor must retain evidence of a passed
background check for each staff and a written policy that all newly hired staff undergo a background
check. If such evidence cannot be provided, all applicable staff must undergo the County’s standard
background check. The background check will include fingerprinting by the County Sheriff's Office, a
credit check and Virginia Department of Social Services Central Registry check.

16. REPLACEMENT OF PERSONNEL AND SUBCONTRACTORS

The County has the right reasonably to reject staff or subcontractors whom the Contractor assigns to the

project. The Contractor must then provide replacement staff or subcontractors satisfactory to the County
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in a timely manner and at no additional cost to the County. The day-to-day supervision and control of the
Contractor's and its subcontractors’ employees is the sole responsibility of the Contractor.

The Contractor may not replace key personnel or subcontractors identified in its proposal, including the
approved Project Manager, without the County's written approval. The Contractor must submit any
request to remove or replace key personnel or subcontractors to the County Project Officer at least 15
calendar days in advance of the proposed action. The request must contain a detailed justification,
including identification of the proposed replacement and his or her qualifications.

If the approved Project Manager must be absent for an extended period, the Contractor must provide an
interim Project Manager, subject to the County’s written approval.

If the approved Project Manager resigns or is terminated by the Contractor, the Contractor will replace
the Project Manager with an individual with similar qualifications and experience, subject to the County's
written approval.

17. *EMPLOYMENT DISCRIMINATION BY CONTRACTOR PROHIBITED
During the performance of its work pursuant to this Contract:

A. The Contractor will not discriminate against any employee or applicant for employment
because of race, religion, color, sex, nationa! origin, age or disability or on any other basis
prohibited by state law. The Contractor agrees to post in conspicuous places, available to
employees and applicants for employment, notices setting forth the provisions of this
nondiscrimination clause.

B. Notices, advertisements and solicitations placed in accordance with federal law, rule or
regulation will be deemed sufficient for meeting the requirements of this section.

C. The Contractor will state in all solicitations or advertisements for employees that it places or
causes to be placed that such Contractor is an Equa! Opportunity Employer.

D. The Contractor will comply with the provisions of the Americans with Disabilities Act of 1990
(“ADA"), which prohibits discrimination against individuals with disabilities in employment
and mandates that disabled individuals be provided access to publicly and privately provided
services and activities.

E. The Contractor must include the provisions of the foregoing paragraphs in every subcontract
or purchase order of more than $10,000.00 relating to this Contract so that the provisions
will be binding upon each subcontractor or vendor.

18. *EMPLOYMENT OF UNAUTHORIZED ALIENS PROHIBITED

In accordance with §2.2-4311.1 of the Code of Virginia, as amended, the Contractor must not during the
performance of this Contract knowingly employ an unauthorized alien, as that term is defined in the
federal Immigration Reform and Control Act of 1986.

19, *DRUG-FREE WORKPLACE TO BE MAINTAINED BY CONTRACTOR

During the performance of this Contract, the Contractor must: (i) provide a drug-free workplace for its

employees; (ii}) post in conspicuous places, available to employees and applicants for employment, a

statement notifying employees that the unlawful manufacture, sale, distribution, dispensation,
Page 6 of 74



possession, or use of a controlled substance or marijuana is prohibited in the Contractor's workplace and
specifying the actions that will be taken against employees for violating such prohibition; {iii) state in all
solicitations or advertisements for employees placed by or on behalf of the Contractor that the
Contractor maintains a drug-free workplace; and {iv) include the provisions of the foregoing clauses in
every subcontract or purchase order of more than $10,000.00 relating to this Contract so that the
provisions will be binding upon each subcontractor or vendor.

For the purposes of this section, "workplace" means the site(s) for the performance of the work required
by this Contract.

20. SAFETY

The Contractor must ensure that it and its employees and subcontractors comply with all applicable local,
state and federal policies, regulations and standards relating to safety and health, including the standards
of the Virginia Occupational Safety and Health program of the Department of Labor and Industry for
General Industry and for the Construction Industry and the applicable Federal Environmental Protection
Agency and Virginia Department of Environmental Quality standards.

21, TERMINATION

The County may terminate this Contract at any time as follows: (1) for cause, if, as determined by the
County, the Contractor is in breach or default or has failed to perform the Work satisfactorily; or (2) for
the convenience of the County.

Upon receipt of a notice of termination, the Contractor must not place any further orders or subcontracts
for materials, services or facilities; must terminate all vendors and subcontracts, except as are necessary
for the completion of any portion of the Work that the County did not terminate; and must immediately
deliver all documents related to the terminated Wark to the County.

Any purchases that the Contractor makes after the notice of termination will be the sole responsibility of
the Contractor, unless the County has approved the purchases in writing as necessary for completion of

any portion of the Work that the County did not terminate.

If any court of competent jurisdiction finds a termination for cause by the County to be improper, then
the termination will be deemed a termination for convenience.

A. TERMINATION FOR CAUSE, INCLUDING BREACH AND DEFAULT; CURE

1. Termination for Unsatisfactory Performance. If the County determines that the Contractor
has failed to perform satisfactorily, then the County will give the Contractor written notice of
such failure(s) and the opportunity to cure them within 30 days or any other period specified
by the County (“Cure Period”). If the Contractor fails to cure within the Cure Period, the
County may terminate the Contract for failure to provide satisfactory performance by
providing written notice with a termination date. Upon such termination, the Contractor may
apply for compensation for Contract services that the County previously accepted
(“Termination Costs”), unless payment is otherwise barred by the Contract. The Contractor
must submit any request for Termination Costs, with all supporting documentation, to the
County Project Officer within 30 days after the expiration of the Cure Period. The County may
accept or reject the request for Termination Costs, in whole or in part, and may notify the
Contractor of its decision within a reasonable time.
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In the event of termination by the County for failure to perform satisfactorily, the Contractor
must continue to provide its services as previously scheduled through the termination date,
and the County must continue to pay all fees and charges incurred through the termination
date,

2. Termination for Breach or Default. If the County terminates the Contract for default or
breach of any Contract provision or condition, then the termination will be immediate after
notice of termination to the Contractor (unless the County provides for an opportunity to
cure), and the Contractor will not be permitted to seek Termination Costs.

Upon any termination pursuant to this section, the Contractor will be liable to the County for
costs that the County must expend to complete the Work, including costs resulting from any
related delays and from unsatisfactory or non-compliant work performed by the Contractor
or its subcontractors. The County will deduct such costs from any amount due to the
Contractor; or if the County does not owe the Contractor, the Contractor must promptly pay
the costs within 15 days of a demand by the County. This section does not limit the County’s
recovery of any other damages to which it is entitled by law.

Except as otherwise directed by the County, the Contractor must stop work on the date of
receipt the notice of the termination.

8. TERMINATION FOR THE CONVENIENCE OF THE COUNTY

The County may terminate this Contract in whole or in part whenever the Purchasing Agent
determines that termination is in the County's best interest. The County will give the Contractor at
least 15 days’ notice in writing. The notice must specify the extent to which the Contract is
terminated and the effective termination date. The Contractor will be entitled to Termination Costs,
as defined above, plus any other reasonable amounts that the parties might negotiate; but no
amount will be allowed for anticipatory profits.

Except as otherwise directed by the County, the Contractor must stop work on the date of receipt of
the notice of the termination.

C. TRANSITION SERVICES

In the event this Agreement is terminated for any reason, the Contractor agrees to and shall provide
the County with a sufficient number of the Contractor’s personnel, including employees or
independent contractors, each with the ability, experience and qualifications to perform the required
services, to assist the County in transitioning the services being provided hereunder by the Contractor
and transferring the County’s data and information stored in the Licensed Program to a replacement
system or program (the “Transition Services”). Fees for the Contractor’s personnel providing the
Transition Services shall be charged at the then current support and consulting fee rates contained in
Attachment B. Contractor expressly grants County all rights necessary to transition data to alternative
formats and to provide access to the System ("System” shall mean all software and/or hardware
related to the operating environment.).

The Contractor shall provide the County with License rights and Services, as required for County to

achieve a timely and orderly transition. All Transition Services invoices are due and payable in full

within thirty (30) days of date of invoice acceptance and approval by the Project Officer. County

agrees that it will promptly notify Contractor in writing of any dispute with any Transition Services

invoice, and that Transition Services invoices for which no such notification is received will deemed
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accepted by County and true and correct thirty (30) business days after they are sent by Contractor.
In the event of a dispute of any invoice, Contractor agrees to review the disputed items in good faith.
Upon completion of the review by Contractor it will send written notice of the dispute to County and
County agrees to respond in writing to Contractor for continued disputes or pay the amounts.

22. INDEMNIFICATION

The Contractor covenants for itself, its employees and its subcontractors to save, defend, hold harmless
and indemnify the County and all of its elected and appointed officials, officers, current and former
employees, agents, departments, agencies, boards and commissions (collectively the “County
Indemnitees”) from and against any and all claims made by third parties for any and all losses, damages,
injuries, fines, penalties, costs (including court costs and attorneys’ fees), charges, liability, demands or
exposure (collectively, “Damages”) resulting from, arising out of or in any way connected with the
Contractor’s acts or omissions, including the acts or omissions of its employees and/or subcontractors, in
performance or nonperformance of the Contract; provided, however, that the foregoing obligations shall
not apply in the event of any negligence or willful misconduct by the County, its current and former
employees or agents, excluding Contractor and Contractor’s subcontractors. This duty to save, defend,
hold harmless and indemnify will survive the termination of this Contract. If the Contractor fails or refuses
to fulfill its obligations contained in this section, the Contractor must reimburse the County for any and all
resulting payments and expenses, including reasonable attorneys’ fees. The Contractor must pay such
expenses upon demand by the County, and failure to do so may result in the County withholding such
amounts from any payments to the Contractor under this Contract.

23. INTELLECTUAL PROPERTY INDEMNIFICATION

The Contractor warrants and guarantees that in providing services under this Contract neither the
Contractor nor any subcontractor is infringing on the intellectual property rights (including, but not
limited to, copyright, patent, mask and trademark) of third parties.

If the Contractor or any of its employees or subcontractors uses any design, device, work or material that
is covered by patent or copyright, it is understood that the Contract Amount includes all royalties,
licensing fees, and any other costs arising from such use in connection with the Work under this Contract.

The Contractor covenants for itself, its employees and its subcontractors to save, defend, hold harmless,
and indemnify the County Indemnitees, as defined above, from and against any and all claims, losses,
damages, injuries, fines, penalties, costs (including court costs and attorneys’ fees), charges, liability or
exposure for infringement of or on account of any trademark, copyright, patented or unpatented
invention, process or article manufactured or used in the performance of this Contract. This duty to save,
defend, hold harmless and indemnify will survive the termination of this Contract. If the Contractor fails
or refuses to fulfill its obligations contained in this section, the Contractor must reimburse the County for
any and all resulting payments and expenses, including reasonable attorneys’ fees. The Contractor must
pay such expenses upon demand by the County, and failure to do so may result in the County withholding
such amounts from any payments to the Contractor under this Contract.

24, COPYRIGHT

By this Contract, the Contractor irrevocably transfers, assigns, sets over and conveys to the County all
rights, title and interest, including the sole exclusive and complete copyright interest, in any and all
copyrightable works created pursuant to this Contract, other than the Welligent System (including, but
not limited to, all source and object code, documentation and materials relating thereto), any
Enhancements developed by the Contractor, and any proprietary or intellectual property rights of
Welligent existing prior to the date of this Contract or that are owned or developed by Contractor for use
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by other clients of Contractor {regardless of when developed or created). The Contractor will execute any
documents that the County requests to formalize such transfer or assignment.

The rights granted to the County by this section are irrevocable and may not be rescinded or modified,
including in connection with or as a result of the termination of or a dispute concerning this Contract.

The Contractor may not use subcontractors or third parties to develop or provide input into any
copyrightable materials produced pursuant to this Contract without the County’s advance written
approval and unless the Contractor includes this Copyright provision in any contract or agreement with
such subcontractors or third parties related to this Contract.

25. OWNERSHIP AND RETURN OF RECORDS
This Contract does not confer on the Contractor any ownership rights or rights to use or disclose the
County's data or inputs.

All drawings, specifications, blueprints, data, information, findings, memoranda, correspondence,
documents or records of any type, whether written, oral or electronic, and all documents generated by
the Contractor or its subcontractors as a result of this Contract (collectively “Records”} are the exclusive
property of the County and must be provided or returned to the County upon completion, termination, or
cancellation of this Contract. The Contractor will not use or willingly cause or allow such materials to be
used for any purpose other than performance of this Contract without the written consent of the County.

The Records are confidential, and the Contractor will neither release the Records nor share their
contents. The Contractor will refer all inquiries regarding the status of any Record to the Project Officer or
to his or her designee. At the County's request, the Contractor will deliver all Records, including hard
copies of electronic records, to the Project Officer and will destroy all electronic Records.

The Contractor agrees to include the provisions of this section as part of any contract or agreement
refated to this Contract into which it enters with subcontractors or other third parties.

The provisions of this section will survive any termination or cancellation of this Contract.

26. DATA SECURITY AND PROTECTION

The Contractor will hold County information, as defined below, in the strictest confidence and will comply
with all applicable County security and network resources policies, as well as all local, state and federal
laws and regulatory requirements concerning data privacy and security. The Contractor must develop,
implement, maintain, continually monitor and use appropriate administrative, technical and physical
security measures to control access to and to preserve the confidentiality, privacy, integrity and
availability of all electronically maintained or transmitted information received from or created or
maintained on behalf of the County. For purposes of this provision, and as more fully described in this
Contract and in the County’'s Non-Disclosure and Data Security Agreement {NDA), “County Information”
includes, but is not limited to, electronic information; documents; data; images; financial records;
personally identifiable information; personal health information (PHI}; personnel, educational, voting,
registration, tax and assessment records; information related to public safety; County networked
resources; and County databases, software and security measures that are created, maintained,
transmitted or accessed to perform the Work under this Contract.

{(a) County's Non-Disclosure and Data Security Agreement. The Contractor and its Designees
(Contractor Designees shall include, but shall not be limited to, all Contractor-controlled
Page 10 of 74



(b}

(d)

(f)

agents or subcontractors working on-site at County facilities or otherwise performing any
work under this Contract) must sign the NDA (Attachment D — County Nondisclosure and
Data Security Agreement (Contractor) before performing any work or obtaining or
permitting access to County networked resources, application systems or databases. The
Contractor will make copies of the signed NDAs available to the County Project Officer upon
request.

Use of Data. The Contractor will ensure against any unauthorized use, distribution or
disclosure of or access to County Information and County networked resources by itself or
its Designees. Use of County Information other than as specifically outlined in the Contract
Documents is strictly prohibited. The Contractor will be solely responsible for any
unauthorized use, reuse, distribution, transmission, manipulation, copying, modification,
access to or disclosure of County Information and for any non-compliance with this
provision by itself or by its Designees.

Data Protection. The Contractor will protect the County’s Information according to standards
established by the National Institute of Standards and Technology, including 201 CMR 17.00,
Standards for the Protection of Personal Information of Residents of the Commonwealth
and the Payment Card Industry Data Security Standard (PCI DSS), as applicable, and no less
rigorously than it protects its own data and proprietary or confidential information. The
Contractor must provide to the County a copy of its data security policy and procedures for
securing County Information and a copy of its disaster recovery plan(s). If requested by the
County, the Contractor must also provide annually the results of an internal Information
Security Risk Assessment provided by an outside firm.

Security Requirements. The Contractor must maintain the most up-to-date anti-virus
programs, industry-accepted firewalls and other protections on its systems and networking
equipment. The Contractor certifies that all systems and networking equipment that
support, interact with or store County Information meet the above standards and industry
best practices for physical, network and system security requirements. Printers, copiers or
fax machines that store County Data into hard drives must provide data-at-rest encryption.
The County’s Chief Information Security Officer or designee must approve any deviation
from these standards. The downloading of County information onte laptops, other portable
storage media or services such as personal e-mail, Dropbox etc. is prohibited without the
written authorization of the County's Chief Information Security Officer or designee.

Conclusion of Contract. Within 30 days after the termination, cancellation, expiration or
other conclusion of the Contract, the Contractor must, at no cost to the County, return all
County Information to the County in an electronic format defined by the County Project
Officer. The County may request that the Information be destroyed. The Contractor is
responsible for ensuring the return and/or destruction of all Information that is in the
possession of its subcontractors or agents. The Contractor must certify completion of this
task in writing to the County Project Officer.

Notification of Security Incidents. The Contractor must notify the County Chief Information
Officer and County Project Officer within 24 hours of the discovery of any unintended access
to or use or disclosure of County Information.
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{(g) Subcontractors. If subcontractors are permitted under this Contract, the requirements of
this entire section must be incorporated into any agreement between the Contractor and
the subcontractor. If the subcontractor will have access to County Information, each
subcontractor must provide to the Contractor a copy of its data security policy and
procedures for securing County Information and a copy of its disaster recovery plan(s).

27. REPRESENTATIONS AND WARRANTIES

A. Warranty as to No Viruses or Malicious Codes. The Contractor warrants and represents to
County that the Licensed Program does not contain any virus, worm, time bomb, trap door,
disabling device, automatic restraint, Trojan Horse, cookies, hyperlinks, contaminants,
commands, or other codes designed to: (a) discontinue the County’s effective use of the
Licensed Program; (b) erase, destroy, corrupt, or modify any data of the County, the
County’s employees, agents, and/or patients, or any Named User, without the express
written consent of the County; or {c) bypass any internal or external software security
measure to obtain access to any hardware or software of the County or the County’s
employees, agents, and/or patients, without the express written consent of the County.

B. Other Representations and Warranties. The Contractor represents and warrants to the
County as follows:
1.  That it has the right, power and authority to enter into this Agreement and to fully
perform its obligations hereunder;

2. That it either owns or has sufficient legal rights in and to the Licensed Program and
Upgrades to meet all of its obligations hereunder;

3. That the County’s permitted use and possession of the Licensed Program and
Upgrades will not be interrupted or otherwise disturbed by any entity successfully
asserting a claim related to the Licensed Program or Upgrades or any portion
thereof;

4. That neither the Licensed Program nor the Upgrades nor the County’s employees,
agents, or patients, and Named Users’ use thereof will infringe any U.S. or foreign
patents, trademark, copyright, privacy rights, publicity rights, or other proprietary
right of any third party;

5.  The Contractor has obtained any licenses, permits, approvals, or authorizations, if
any, required for the proper and lawful performance of this Agreement at the
Contractor’s sole cost and expense;

6. That the Licensed Program and Upgrades, and/or any portion thereof, do not
constitute and will not give rise to a claim of Infringement due to the actions or
omissions of the Contractor or any employee, agent, or contractor of the Contractor;

7. That all of the services to be provided by the Contractor hereunder will be performed
in a professional manner by gualified personnel or qualified contractors; and

8. In providing the Licensed Program and Upgrades and in performing services
hereunder, the Contractor and its employees, agents, and contractors shall comply
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with all applicable Federal, state, and local laws and regulations, including, without
limitation, HIPAA and the rules and regulations promulgated thereunder, and all
applicable United States import and export laws, statutes, and regulations, including,
but not limited te, the 12 Export Administration Regulations and International Traffic
in Arms Regulations.

8.  Contractor warrants that any distributed media containing the Licensed Program is
and will be free from physical defects in the media that tangibly embodies Licensed
Software.

10. Contractor warrants that the Licensed Program is a Certified EHR, which certification
is current as of 2017, and Contractor shall obtain or renew such certification as
required under American Recovery and Reinvestment Act of 2009, and the applicable
regulations, in order for County to participate in any EHR incentive programs.

11.  Contractor warrants that the Licensed Programs will substantially conform in all
material respects with their Specifications, the schedules and SOWs under this
Agreement, and additionally, with all express representations made in the
Functionality Matrix attached hereto as Attachment P. If a Problem Error occurs
while County is receiving Support Services, Contractor will correct the Problem Error
in accordance with the Support Services provisions set forth in Attachment H.

12.  Contractor warrants and represents that each person assigned to the performance of
this Agreement will have the skill and knowledge necessary to perform the Services
described in this Agreement substantially in accordance with the requirements and
within the timeframes established in the Statement of Work (absent a force majeure
event or delays due to County).

Warranty Disclaimer. Except as otherwise expressly provided in this Agreement, the Licensed
Program has no implied warranties of any kind and the Contractor does not make any
warranty, express or implied, with respect to the performance of Licensed Program or the
results obtained therefrom, including, without limitation, any implied warranty or
merchantability or fitness for a particular purpose, unless the standard of performance is in
writing and signed by an authorized representative of the parties or as expressly provided in
this Agreement. The software service is provided “As Is”. Except as specifically set forth in
this Agreement, there are no other warranties, whether written or oral, express or implied,
with respect to the subject matter of this Agreement or any exhibit, including any implied
warranties of merchantability or implied warranties of fitness or suitability for a particular
purpose, {whether or not Welligent knows, has reason to know, has been advised, or is
otherwise in fact aware of any such purpose), whether alleged to arise by law, by reason of
custom or usage in trade, or by course of dealing. in addition, Welligent expressly disclaims
any warranty or representation to any person or organization other than the County with
respect to the software service or any part thereof and any warranty or representation to the
County that is not included in this Agreement. It is understood that the software service will
be used in the delivery of clinical services and administration of human service programs, and
agreed that responsibility for all decisions relating to the provision of treatment, payment of
benefits and allocation of resources are the responsibility of the County and its authorized
users, and not the responsibility of Welligent.
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28. LIMITATION OF LIABILITY

EXCEPT FOR BREACHES OF SECTION 22, 23 and Attachment C (Business Associate Agreement}, IN NO
EVENT WILL CONTRACTOR BE LIABLE FOR ANY LOSS OF PROFITS, LOSS OF USE, BUSINESS INTERRUPTION,
LOSS OF DATA, OR INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND IN
CONNECTION WITH THIS CONTRACT. THE USE OF THE WELLIGENT SYSTEM, THE INABILITY TO ACCESS THE
WELLIGENT SYSTEM, SOFTWARE OR SERVICE, OR COUNTY DATA, SLOW OR INTERRUPTED ACCESS TO THE
WELLIGENT SYSTEM BEYOND CONTRACTOR'S CONTROL. EXCEPT AS OTHERWISE PROVIDED HEREIN,
CONTRACTOR’S ENTIRE LIABILITY FOR DAMAGES OF ANY KIND UNDER ANY THEORY OR LAW WHATSOEVER
SHALL NOT EXCEED THE GREATER OF THE AMOUNT OF FEES PAID BY THE COUNTY HEREUNDER OR THE
INSURANCE COVERAGE THAT CONTRACTOR IS REQUIRED TO CARRY AS SPECIFIED IN THIS CONTRACT.

29, *ETHICS IN PUBLIC CONTRACTING

This Contract incorporates by reference Article 9 of the Arlington County Purchasing Resolution, as well as
all state and federal laws related to ethics, conflicts of interest or bribery, including the State and Local
Government Conflict of Interests Act (Code of Virginia § 2.2-3100 et seq.), the Virginia Governmental
Frauds Act (Code of Virginia § 18.2-498.1 et seq.) and Articles 2 and 3 of Chapter 10 of Title 18.2 of the
Code of Virginia, as amended (§ 18.2-438 et seq.). The Contractor certifies that its proposal was made
without collusion or fraud; that it has not offered or received any kickbacks or inducements from any
other offeror, supplier, manufacturer or subcontractor; and that it has not conferred on any public
employee having official responsibility for this procurement any payment, loan, subscription, advance,
deposit of money, services or anything of more than nominal value, present or promised, unless
consideration of substantially equal or greater value was exchanged.

30. *COUNTY EMPLOYEES
No Arlington County employee may share in any part of this Contract or receive any benefit from the
Contract that is not available to the general public.

31. NO RECRUITING OF EMPLOYEES
Contractor and County agree that neither party will actively recruit each other’s employees during the
term of this Agreement without prior written approval.

32. FORCE MAJEURE

Neither party will be held responsible for failure to perform the duties and responsibilities imposed by
this Contract if such failure is due to a fire, riot, rebellion, natural disaster, war, act of terrorism or act of
God that is beyond the control of the party and that makes performance impossible or illegal, unless
otherwise specified in the Contract.

33. *AUTHORITY TO TRANSACT BUSINESS

The Contractor must, pursuant to Code of Virginia § 2.2-4311.2, be and remain authorized to transact
business in the Commonwealth of Virginia during the entire term of this Contract. Otherwise, the
Contract is voidable at the sole option of and with no expense to the County.

34, *RELATION TO COUNTY

The Contractor is an independent contractor, and neither the Contractor nor its employees or
subcontractors will be considered employees, servants or agents of the County. The County will not be
responsible for any negligence or other wrongdoing by the Contractor or its employees, servants or
agents. The County will not withhold payments to the Contractor for any federal or state unemployment
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taxes, federal or state income taxes or Social Security tax or for any other benefits. The County will not
provide to the Contractor any insurance coverage or other benefits, including workers' compensation,

35. ANTITRUST

The Contractor conveys, sells, assigns and transfers to the County all rights, title and interest in and to all
causes of action under state or federal antitrust laws that the Contractor may have relating to this
Contract.

36. REPORT STANDARDS

The Contractor must submit all written reports required by this Contract for advance review in a format
approved by the Project Officer. Reports must be accurate and grammatically correct and should not
contain spelling errors. The Contractor will bear the cost of correcting grammatical or spelling errors and
inaccurate report data and of other revisions that are required to bring the report(s) into compliance with
this section.

Whenever possible, proposals must comply with the following guidelines:

e printed double-sided on at least 30% recycled-content and/or tree-free paper

e recyclable and/or easily removable covers or binders made from recycled materials
(proposals with glued bindings that meet all other requirements are acceptable)

* avoid use of plastic covers or dividers

* avoid unnecessary attachments or documents or superfluous use of paper (e.g. separate
title sheets or chapter dividers)

37. AUDIT

The Contractor must retain all books, records and other documents related to this Contract for at least
five years after the final payment and must allow the County or its authorized agents to examine the
documents during this period and during the Contract Term. The Contractor must provide any requested
documents to the County for examination within 15 days of the request, at the Contractor’s expense.
Should the County’s examination reveal any overcharging by the Contractor, the Contractor must, within
30 days of County’s request, reimburse the County for the overcharges and for the reasonable costs of
the County’s examination, including, but not limited to, the services of external audit firm and attorney’s
fees; or the County may deduct the overcharges and examination costs from any amount that the County
owes to the Contractor. If the Contractor wishes to destroy or dispose of any records related to this
Contract (including confidential records to which the County does not have ready access) within five years
after the final payment, the Contractor must give the County at least 30 days’ notice and must not
dispose of the documents if the County objects.

38. ASSIGNMENT
The Contractor may not assign, transfer, convey or otherwise dispose of any award or any of its rights,
obligations or interests under this Contract without the prior written consent of the County.

39. AMENDMENTS

This Contract may not be modified except by written amendment executed by persons duly authorized to
bind the Contractor and the County.
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40, *ARLINGTON COUNTY PURCHASING RESOLUTION AND COUNTY POLICIES
Nothing in this Contract waives any provision of the Arlington County Purchasing Resolution, which is
incorporated herein by reference, or any applicable County policy.

41, *DISPUTE RESOLUTION

All disputes arising under this Agreement or concerning its interpretation, whether involving law or fact
and including but not limited to claims for additional work, compensation or time, and all claims for
alleged breach of contract must be submitted in writing to the Project Officer as soon as the basis for the
claim arises. In accordance with the Arlington County Purchasing Resolution, claims denied by the Project
Officer may be submitted to the County Manager in writing no later than 60 days after the final payment.
The time limit for a final written decision by the County Manager is 30 days. Procedures concerning
contractual claims, disputes, administrative appeals and protests are contained in the Arlington County
Purchasing Resolution. The Contractor must continue to work as scheduled pending a decision of the
Project Officer, County Manager, County Board or a court of law.

42, *APPLICABLE LAW, FORUM, VENUE AND JURISDICTION

This Contract is governed in all respects by the laws of the Commonwealth of Virginia; and the
jurisdiction, forum and venue for any litigation concerning the Contract or the Work is in the Circuit Court
for Arlington County, Virginia, and in no other court.

43, ARBITRATION
No claim arising under or related to this Contract may be subject to arbitration.

44, NONEXCLUSIVITY OF REMEDIES
All remedies available to the County under this Contract are cumulative, and no remedy will be exclusive
of any other at law or in equity.

45, NO WAIVER

The failure to exercise a right provided for in this Contract will not be a subsequent waiver of the same
right or of any other right.

46. SEVERABILITY

The sections, paragraphs, clauses, sentences, and phrases of this Contract are severable; and if any
section, paragraph, clause, sentence or phrase of this Contract is declared invalid by a court of competent
jurisdiction, the rest of the Contract will remain in effect.

47. ATTORNEY’S FEES
The County is entitled to attorney’s fees and costs that it incurs to enforce any provision of this Contract.

48. SURVIVAL OF TERMS

In addition to any numbered section in this Agreement which specifically state that the term or paragraph
survives the expiration of termination of this Contract, the following sections if included in this Contract
also survive: INDEMNIFICATION; RELATION TO COUNTY; OWNERSHIP AND RETURN OF RECORDS; AUDIT;
COPYRIGHT,; INTELLECTUAL PROPERTY INDEMNIFICATION; WARRANTY; CONFIDENTIAL INFORMATION;
AND DATA SECURITY AND PROTECTION.

49, HEADINGS
The section headings in this Contract are inserted only for convenience and do not affect the substance of
the Contract or limit the sections’ scope.
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50. AMBIGUITIES

The parties and their counsel have participated fully in the drafting of this Agreement; and any rule that
ambiguities are to be resolved against the drafting party does not apply. The language in this Agreement
is to be interpreted as to its plain meaning and not strictly for or against any party.

51. NOTICES

Unless otherwise provided in writing, all written notices and other communications required by this
Contract are deemed to have been given when either (a) delivered in person; (b) delivered by an agent,
such as a delivery service; or {c) deposited in the United States mail, postage prepaid, certified or
registered and addressed as follows:

TO THE CONTRACTOR:
Welligent

5205 Colley Avenue
Norfolk, Virginia 23508

TO THE COUNTY:

Chris Green, Project Officer

2100 Washington Boulevard — 3™ Floor
Arlington, Virginia 22204

AND

Michael E. Bevis, Purchasing Agent
Arlington County, Virginia

2100 Clarendon Boulevard, Suite 500
Arlington, Virginia 22201

52. *NON-DISCRIMINATION NOTICE
Arlington County does not discriminate against faith-based organizations.

53. LIMITED ENGLISH PROFICIENCY

The Contractor must comply with Executive Order 13166, Title VI of the Civil Rights Act of 1964 and make
reasonable efforts to ensure that as part of the services that it provides, adequate communication
services, including interpretation and translation, are available to persons who have limited English
proficiency. If such services are not included in the Contract’s scope of services and pricing, the
Contractor will use a County-contracted service provider, and the County will pay the fees.

54. HIPAA COMPLIANCE

The Contractor must comply with the privacy, security and electronic transaction components of the
Health Insurance Portabiiity and Accountability Act of 1996, as amended (“HIPAA™). Pursuant to 45 C.F.R.
§164.502(e) and §164.504(e), the Contractor is designated a Business Associate for purposes of this
Contract and must execute the attached Arlington County Business Associate Agreement (Attachment C
Business Associate Agreement). Pursuant to 45 C.F.R. § 164.308(b}{(1} and the Health Information
Technology for Economic and Clinic Health Act ("HITECH"), & 13401, the Contractor must alse enter into
an agreement with any subcontractors that, in a form approved by the County, requires the
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subcontractor to protect PHI to the same extent as the Arlington County Business Assaciate Agreement.
The Contractor must ensure that its subcontractors notify the Contractor immediately of any breaches in
security regarding PHI. Software and platforms used in performance of this Contract must be HIPAA
compliant.

The Contractor takes full responsibility for HIPAA compliance, for any failure to execute the appropriate
agreements with its subcontractors and for any failure of its subcontractors to comply with the existing or
future regulations of HIPAA and/or HITECH. The Contractor will indemnify the County for any and all
losses, fines, damages, liability, exposure or costs that arise from any failure to comply with this
paragraph.

55. ACCESSIBILITY OF WEB SITE

If any work performed under this Contract results in the design, development or maintenance of or
responsibility for the content or format of any County web sites or for the County’s presence on third-
party web sites, the Contractor must perform such work in compliance with ADA.

S6. ADA COMPLIANCE

The Contractor is solely responsible for its compliance with the ADA and must defend and hold the
County harmless from any expense or liability arising from the Contractor’s non-compliance. The
Contractor also must respond promptly to and cooperate fully with all inquiries from the U.S. Department
of Labor.

The Contractor’s responsibilities related to ADA compliance include, but are not limited to, the following:

a. Access to Programs, Services and Facilities: The Contractor must ensure that its programs,
services and facilities are accessible to persons with disabilities. If a particular facility or program
is not accessible, the Contractor must provide equivalent services in an accessible alternate
location or manner.

b. Effective  Communication: Upon request, the Contractor, must provide appropriate
communication aids and services so that qualified persons with disabilities can participate equally
in the Contractor's programs, services and activities, Communication aids and services can
include, but are not limited to, qualified sign language interpreters, Braille documents and other
means of facilitating communications with people who have speech, hearing or vision
impairments.

C. Modifications to Policies and Procedures: The Contractor must modify its policies and procedures
as necessary to ensure that people with disabilities have an equal opportunity to enjoy the
Contractor's programs, services and activities. For example, individuals’ service animals must be
allowed in the Contractor's offices or facilities, even if pets are generally prohibited.

d. No Extra Charges: The Contractor may not charge a person with a disability or any group of
individuals with disabilities to cover the cost of providing aids or services or of reasonable
modifications to policies and procedures,

57. INSURANCE REQUIREMENTS

Before beginning work under the Contract or any extension, the Contractor must provide to the County

Purchasing Agent a Certificate of Insurance indicating that the Contractor has in force at a minimum the

coverage below. The Contractor must maintain this coverage until the completion of the Contract or as
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otherwise stated in the Contract Documents. All required insurance coverage must be acquired from
insurers that are authorized to do business in the Commonwealth of Virginia, with a rating of “A-"or
better and a financial size of “Class VII” or better in the latest edition of the A.M. Best Co. Guides.

a. Workers Compensation - Virginia statutory workers compensation {(W/C) coverage, including
Virginia benefits and employer’s liability with limits of $100,000/100,000/500,000. The County
will not accept W/C coverage issued by the Injured Worker's Insurance Fund, Towson, MD.

b. Emplovyer’s Liability - $100,000/accident, $100,000/disease, $5000,000 disease policy limit

c. Commercial General Liability - $1,000,000 per occurrence, with $2,000,000 annual aggregate
covering all premises and operations and including personal injury, completed operations,
contractual liability, independent contractors, and products hability. The general aggregate limit
must apply to this Contract. Evidence of contractual liability coverage must be typed on the

certificate.
d. Business Automobile Liability - $1,000,000 combined single-limit {owned, non-owned and hired)
e. Independent Contractors - $500,000 CSL BI/PD each occurrence, $1,000,000 annual aggregate
f. Umbrella/Excess Liability - $1,000,000 Bodily Injury, Property Damage and Personal Injury
g. Miscellaneous E&Q - $1,000,000 per occurrence/claim
h. Cyber Insurance - $2,000,000 per occurrence, $2,000,000 annual aggregate

i. Additional Insured — The County and its officers, elected and appointed officials, employees and
agents must be named as additional insureds on all policies except workers compensation and
automotive and professional liability; and the additional insured endorsement must be typed on
the certificate.

J- Canceilation - If there is a material change or reduction in or cancellation of any of the above
coverages during the Contract Term, the Contractor must notify the Purchasing Agent
immediately and must, with no lapse in coverage, obtain replacement coverage that is consistent
with the terms of this Contract. Not having the required insurance throughout the Contract Term
is grounds for termination of the Contract.

k. Claims-Made Coverage - Any “claims made” policy must remain in force, or the Contractor must
obtain an extended reporting endorsement, until the applicable statute of limitations for any
claims has expired.

Contract Identification - All insurance certificates must state this Contract's number and title.

The Contractor must disclose to the County the amount of any deductible or self-insurance component of
any of the required policies. With the County’s approval, the Contractor may satisfy its obligations under
this section by self-insurance for all or any part of the insurance required, provided that the Contractor
can demonstrate sufficient financial capacity. In order to do so, the Contractor must provide the County
with its most recent actuarial report and a copy of its self-insurance resolution.
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The County may request additional information to determine if the Contractor has the financial capacity
to meet its obligations under a deductible and may require a lower deductible; that funds equal to the
deductible be placed in escrow; a certificate of self-insurance; collateral; or another mechanism to
guarantee the amount of the deductible and ensure protection for the County.

The County's acceptance or approval of any insurance will not relieve the Contractor from any liability or
obligation imposed by the Contract Documents,

The Contractor is responsible for the Work and for all materials, tools, equipment, appliances and
property used in connection with the Work. The Contractor assumes all risks for direct and indirect
damage or injury to the property used or persons employed in connection with the Work and for of all
damage or injury to any person or property, wherever located, resulting from any action, omission,
commission or operation under the Contract or in connection in any way whatsoever with the Work, The

Contractor’s insurance shall be the primary non-contributory insurance for any work performed under
this Contract.

The Contractor is as fully responsible to the County for the acts and omissions of its subcontractors and of

persons employed by them as it is for acts and omissions of persons whom the Contractor employs
directly.

WITNESS these signatures:

THE COUNTY BOARD OF ARLINGTON WELLIGENT
COUNTY, VIRGINIA

AUTHORIZED MC
SIGNATURE: m (/\04/\_)

NAME: MICHAEL E. BEVIS NAME: M\{ AR IN)
TITLE: PURCHASING AGENT TITLE: Pésident

DATE:_BJ_?]/&OF? DATE: \2 l/"l' ( ZoiF
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ATTACHMENT A

SCOPE OF WORK

The scope of work includes configuration and implementation of an Electronic Health Record and Practice
Management System (EHR) for the Arlington County Community Services Board (CSB). This work includes
ensuring the EHR is consistent with the County’s focus to efficiently and effectively provide a wide range
of quality services to the people served. The goal is to be live in the new system before the contract for
the existing system expires in December, 2018.

The Contractor’s configuration must include consideration of the planning information provided and
included in the RFP, pages 10-16 (Attachment S) in the form of a project vision (Guiding Principles and
Goals), high-level summaries of the Arlington County organization (Conceptual Models), current/ future
state workflow details (Process Flows), and a list of requirements (Functionality Matrix) that need to be
addressed in Arlington County’s future EHR.

1. IMPLEMENTATION SCOPE
The Contractor shall provide:

a.  Conversion of data sets during implementation, including an automated process
for uploading existing data into the system at go-live — Described in the
“Conversion Matrix” section (Attachment N).

b.  Interfaces that will be built to other systems - Described in the “Interface Matrix”
section (Attachment P)

c.  Efficient means for end-user entry of data into the system in a method that
effectively supports the CSB - Described in the “Forms List” section (Attachments
L and M). Note thatit is expected that Contractor will not build these forms as
they exist today, but will work with the County to refine processes and
procedures for an efficient electronic system.

d.  Configuration of the system to support CSB billing - Described in the “Billing Setup”
section (Attachment O). The Contractor shall be responsible for configuring each
of the payers and billing rules to be able to accurately bill each payer at go-live.

e.  Provide required program setup - Described in the “Program Setup” identified as
item 6 below. The Contractor shall configure each of the programs and rules to be
able to provide the outlined services in each Program.

f.  Report Creation - Described in the “Report Creation” identified as item 7 below.
Describes reports and reporting related functionality to be built by Contractor.

g.  Provide Implementation Support - Described in the “Implementation Support”
identified as item 8 below. Describes implementation services, such as project
management and subject matter expertise provided by the Contractor.

2. FUNCTIONALITY MATRIX
The Contractor shal! provide the key requirements for the Welligent system’s operation as defined in the
functionality matrix {Attachment P) and Attachment R.
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3. SUPPORT OF COUNTY PROCESSES

The Contractor must execute the system workflow in accordance with the County’s requirements
provided in the RFP's Appendix B. The Contractor shall configure the support for those workflows
effectively in the system and any changes to the County’s processes shall require the approval of the
Project Officer as part of the implementation project.

4. CONVERSION MATRIX

The implementation requires the Contractor to process the migration of data into the new system,
including an automated process for upload of current data for go-live. A description of the reqguired data
to be loaded into the Welligent system is defined in Attachment N. The County will be responsible for
data clean-up and data extraction from source systems (including manual preparation of data as needed).
The Contractor shall perform bulk load processes and report errors back to the County in a format
determined by the County Project Officer. The Contractor shall provide a data format as well as required
rules for the data to be successfully loaded into the Contractor's database. Errors for every column of
each row of a data set should be reported back to the County when a batch is being tested rather than
the “next” error per row. If all errors for all columns can be provided on each test run of a data set, the
scope of conversion shall include three test runs and one final run at go-live for each data set that is in
scope. If all errors for each column of a row are not able to be provided and are instead reported one at
a time, the scope of conversion shall be unbounded and the County will be permitted to run conversions,
any number of times required to produce an errar-free run of the data.

3. INTERFACE MATRIX
Several system interfaces are required for system go-live. Attachment P describes the interface points
between Contractor System and external systems. The County will provide access to each system and
any APl documentation available. The Contractor shall perform work to understand the interface (even if
no documentation exists) and build a working interface between the identified system and the Welligent
system.

4. FORMS LIST

The data capture requirements for the system are provided by identifying input forms. All data capture
reguirements are to be configured by the Contractor during the implementation project. Attachment L
describes the set of data that the Contractor will build their system to capture and manage. Contractor
will not build these exact forms, but will use these forms as reference to the types of data that must be
collected in the system. Actual form implementation will be optimized based on Welligent system
capabilities and County workflows. The forms list includes data to be collected specific to County needs as
well as those that are payer and state requirements and standard assessment forms. Payer, state and
standard forms are to be maintained at no cost to the County as per specifications in Attachment H.
Those forms are defined by their respective publishers {e.g., a state agency); the County can assist in
providing those definitions if needed and requested by the Contractor. The implementation of those
forms must be compliant with the publisher’s intent and maintainable by the Contractor as such. Other
forms included in Attachment L are illustrated in Attachment M,

5. BILLING SETUP

The CSB hills payers for services rendered as well as client-pay options; the Contractor shall configure the
system to suppart these billing functions. Attachment O has descriptions of the required payers in

the billing setup for the Welligent implementation. Due to differences in setup between systems, these
payers may not be replicated in Welligent one-for-one, but Arlington's expectation is that each of these
payers, associated fee schedules, eligibility processes, claims/remittance formats and authorization
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processes will be created by Welligent during the course of the implementation. Arlington's role will be
to provide the details for setup and Welligent will setup the system.

6. PROGRAM SETUP
Describes the programs that will be supported in the system. The Contractor confirms it has read,
understands, and can support the types of Programs outlined in Attachment T.

7. REPORT CREATION

The Contractor shail provide custom reports development to meet the County’s custom reporting
requirements. The Contractor shall develop custom reports as stock Contractor reports, either based on
existing Contractor reports, or as new stock Contractor reports. The County shall provide the Contractor
with written report definition which shall include report description, information sources, columns and
desired filter parameters. For the implementation, this shall include 10 reports, each with up to 10
columns and 4 filter parameters

Contractor shall create a reporting database to allow County staff to write reports and present to end
users via the Contractor’s tools. The Contractor shall create a reporting database in the Contractor’s
server cloud for the County’s private use (Reporting). See Multiple environments in Attachment H.

Report related areas requiring setup shall include:
o (CCS3 reporting. See #3 State and Payer Requirements in Attachment H.
e WaMS reporting. See #8 State and Payer Requirements in Attachment H.

8. IMPLEMENTATION SUPPORT
The County requirements for the Contractor’s personnel, management of the project timeline, and the

process for accepting deliverables are covered under implemetnation support, as defined in Attachment
G.
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ATTACHMENT B

CONTRACT PRICING

License Fees:

1.

4,

The initial license fees for the modules described in Attachment A and for the license grant in
Attachment F are $0. There are no upfront fees as the software is being provided under a
subscription model.

Ongoing license fees are $25 per user per month

Upon release of a sandbox environment for implementation testing, County expects to have
2 30-member implementation team that will need access to the system.

Upon Go-Live, County expects 350 users to be active in the system

Support/Maintenance Fees:

1.

There is no additional fee for support and maintenance beyond the ongoing license fees
outlined above.

There is no additional charge for database storage (including all stock or custom field data).
For attached images {including documents or scanned materials) uploaded into the system,
up to 50GB of data storage is included in the ongoing license fees described above. For each
additional 1 GB of storage above S0GB, the County will pay $5 per 1 GB per month.

Yearly Support / Maintenance fees will be held at the current rates and not raise more than
the amount indicated for maximum increases in Section 6.

Newly developed items created as part of the implementation will not increase
support/maintenance fees.

Subscription Fees:

1.

o

ePrescribing — The first five (5) prescribers are included at no charge {$0). County will pay a
fee of $175 per prescriber per month for each prescriber over five (5) ($2,100 per prescriber
per year).

Lab services - County will pay a fee of $75 per lab per month ($900 per lab per year). The
initial number of labs will be 3.

Wiley Treatment Plan Library - County will pay a fee of $12 per user per month (5144 per
user per year). The initial number of users will be 300.

Commercial Clearinghouse - County will pay a fee of $20 per NPl number per month ($240
per NPl number per year). The initial number of NPl numbers will be 87.

Mailed Patient statements - County will pay a fee of $0.78 per mailed client statement.
Code escrow — County will pay a fee of $900 per year.

FAX - Functionality may be implemented at the County’s discretion. One-time set up cost of
$499. The on-going cost is $150 per month/1,000 out-going FAXES. Volume discounts to be
determined at a Iater date if need exceeds 1,000 per month. In-coming FAX functionality is
available and may be implemented at a later date at the County's discretion.

Fixed Implementation Fees:

1.

The total fixed fee for implementation of the Welligent system at the County will equal
$126,861. This fee is based upon the specific configurations of the Licensed Program per the
Specifications, the scope in Attachment A and the implementation effort described in
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Attachment G. Contractor will deliver the specified scope for a fixed fee regardless of the
hours to accomplish that scope.

2. No Statement of Work (SOW) or additional work will be performed by Contractor, without
written authorization signed by both parties.

3. Payment amounts for implementation fees will be made according to the following schedule
of Payments. Payment processing will be dependent upon the successful completion of
Milestones in Attachment G as determined by the Project Officer.

Schedule of Payments

The following schedule outlines the payment schedule for the items above, as tied to project plan
milestones. A brief description is provided and associated with a milestone ID. The timing of the
Milestone ID is found in the Project Planning Attachment G.

Welligent License, Implementation, Subscriptions, and Maintenance Fees

Milestone Milestone ID Payment

1. Miscellaneous Payment Structure
Contract Signing Milestone — Code Escrow Fees 1.0 $900
Subtotal Misc. Payment Structure S900
2. Implementation Payment Structure
Contract Signing Milestone — Implementation Fees 1.0 $12,685
Project Kickoff Complete 3.0 $6,343
Acceptance test sign-off: Payments shall correspond to the completion of
each of seven iterations. Functionality per iteration will be defined in the
project plan developed by the Contractor and agreed upon by the County.
Each iteration will have its own acceptance of the deliverable. Payment
per iteration will be 1/7 of the amount for this item. 5.2,6.2,7.2,

8.2,9.2,

10.2,11.2 $50,740
Clinical Configuration Complete 13 $6,343
Data conversion Sign-off ready for go-live 16 512,685
Go-Live Complete 19 $12,685
Successful Billing Cycle Post go-live 20 $25,370
Subtotal Implementation Costs (Implementation Fixed Cost) $126,851

Pre = ANse and D ntic R

Testing licenses for implementation (licenses for 30 user implementation
team) 2.0 $9,000
Wiley Testing licenses {licenses for 30 user implementation team prorated
for 6 months of use) 7.2 52,160
Testing licenses for ePrescribing at Clinical Configuration Complete .
(license for up to 5 prescribers included in license fee) 13 'i S0
Subtotal Pre-Live License and Subscription fees 511,160

4. Post-Live License and Subscription fees
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Go-Live Welligent Licenses (licenses for 350 users) 17 105,000
Go-Live ePrescribing Licenses 17 521,000
Go-Live Wiley Library Licenses (licenses for 300 users) 17 543,200
Yearly Code Escrow fee 17 $900
Lab Services 17 $2,700
Commercial Clearinghouse 17 520,880
Subtotal Post-Live License and Subscription fees $193,680
Total Costs
Total Year 1 Costs (Pre Go-Live) $138,911
Total Yearly Costs (After Go-Live) $193,680
Payment parameters

1. Contractor will submit invoices per Section 7 for payment by County with itemized
deliverables for acceptance by County in accordance with the following procedure.

2. All Deliverables, including those listed above, must be reviewed and accepted by the Project
Officer, before the related fees and charges may be invoiced. The acceptance process for
development items will included up to two (2) design sessions and one (1) sign-off meeting.

3. Allitemns related to system functionality, as listed, but not limited to in Attachment F; License
Grant, Attachment A: Scope of Service must be reviewed and accepted by the Project Officer.

4, Acceptance of each milestone will follow the Acceptance procedure for all project
deliverables as outlined in Attachment G.

5. When County has completed its internal quality assurance testing in accordance with the

details outline for Acceptance in Attachment G, County will provide sign-off of acceptance by
Project Officer.

Consulting and Customization fees for additional scope not defined in this agreement:

1.

2.

Work outside of the scope outlined in Attachment A will be billed at the rates below per hour
for software development and consulting time provided by the employees or contractors of
the Licensor.

(a) Project Manager - $200

(b) Senior Technical Lead - 5200

{c) Technical Analyst - $150

(d) Quality Assurance - $125

(e) Training Specialist - $100

These rates will be held constant for a period of two years. After two years, rates may
increase, according to the restrictions outlined in Section 7.
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ATTACHMENT C

BUSINESS ASSOCIATE AGREEMENT

This Business Associate Agreement is hereby entered into between Welligent (hereafter referred to as
“Business Associate”} and the County Board of Arlington County, Virginia (hereafter referred to as
“Covered Entity” or “County”) {collectively "the parties”) and is hereby made a part of any Underlying
Agreement for goods or services entered into between the parties.

Recitals

The County provides services to its residents and employees which may cause it or others under its
direction or control to serve as covered entities for purposes of the Health Insurance Portability and
Accountability Act of 1996 {HIPAA).

The County, in its capacity as a covered entity, may provide Business Associate with certain information
that may include Protected Health Information {PHI), so that Business Associate may perform its
responsibilities pursuant to its Underlying Agreement(s) with and on behalf of County.

Covered Entity and Business Associate intend to protect the privacy of PHI and provide for the security of
any electronic PHI received by Business Associate from Cavered Entity, or created or received by Business
Associate on behalf of Covered Entity in compliance with HIPAA; in compliance with regulations
promulgated pursuant to HIPAA, at 45 CFR Parts 160 and Part 164; and in compliance with applicable
provisions of the Health Information Technology for Economic and Clinical Health Act, as incorporated in
the American Recovery and Reinvestment Act of 2009 {the “HITECH Act”) and any applicable regulations
and/or guidance issued by the U.S. Department of Health and Human Services (“DHHS") with respect to
the HITECH Act (collectively “federal law”).

WHEREAS, federal law and the specific regulations promulgated pursuant to HIPAA at 45 CFR § 164.314,
45 CFR § 164-502(e) and 45 CFR § 164.504(e) require a2 Covered Entity to enter into written agreements

with all Business Associates (hereinafter "Business Associate Agreement”};

WHEREAS, the parties desire to comply with HIPAA and desire to secure and protect such PHI fram
unauthorized disclosure;

THEREFORE, Business Associate and Covered Entity, intending to be legally bound, agree as follows. The
obligations, responsibilities and definitions may be changed from time to time as determined by federal
law and such changes are incorporated herein as if set forth in full text:

1) Definitions

The capitalized terms used in this Business Associate Agreement shall have the meaning set out
below:

a) Accounting. "Accounting" means a record of disclosures of protected health information made by
the Business Associate.
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b)

d)

f)

g)

h)

j)

k)

Breach. “Breach” means the acquisition, access, use, or disclosure of protected health
information in a manner not permitted by this Business Associate Agreement and/or by HIPAA,
which compromises the security or privacy of the protected heaith information. For purposes of
this Business Associate Agreement, any unauthorized acquisition, access, use, or disclosure of
protected health information shall be presumed to be a breach.

Business Associate. “Business Associate” means a person who creates, receives, maintains, or

transmits protected health information on behalf of a Covered Entity to accomplish a task
regulated by HIPAA and not as a member of the Covered Entity's workforce, A Business Associate
shall include, but is not limited to, a non-workforce person/entity who performs data
processing/analysis/transmission, billing, benefit management, quality assurance, legal, actuarial,
accounting, administrative and/or financial services on behalf of the Covered Entity involving
protected health information. A Business Associate also includes a subcontractor.

Covered Entity. “Covered Entity” means a health plan, a health care clearinghouse, and/or a
health care provider who transmits any health information in electronic form in connection with
an activity regulated by HIPAA,

Data Aggregation. "Data Aggregation" means, with respect to PH| created or received by Business
Associate in its capacity as the Business Associate of Covered Entity, the combining of such PHI by
the Business Associate with the PHI received by the Business Associate in its capacity as a
Business Associate of another covered entity, to permit data analyses that relate to the health
care operations of the respective covered entities.

Designated Record Set. “Designated Record Set” means all records, including medical, enroliment,
billing, payment, claims, and/or case management maintained by and/or for a Covered Entity.

Discavery. "Discovery” shall mean the first day an unauthorized use or disclosure is known or
reasonably should have been known by Business Associate, including when it is or should have
been known by any person other than the person who engaged in the unauthorized
use/disclosure who is an employee, officer, or agent of Business Associate.

Electronic Protected Health information. “Electronic Protected Heaith Information” means
individually identifiable health information that is fransmitted by or maintained in electronic
media.

HIPAA. “HIPAA” means the Health Insurance Portability and Accountability Act of 1996 as in effect
and/or as amended.

HITECH Act. “HITECH Act” means the portions of the Health Information Technology for Economic
and Clinical Health Act which serve as amendments to HIPAA. HITECH is included within the
definition of HIPAA unless stated separately.

Individual. “Individual” means the person who is the subject of protected health information
and/or a person who would qualify as a personal representative of the person who is the subject
of protected health information.

Protected Health Information. “Protected Heaith Information” or “PHI” means individually
identifiable health information transmitted and/or maintained in any form.
Page 28 of 74




2)

m) Remuneration. "Remuneration” means direct or indirect payment from or on behalf of a third

n)

o)

p)

a}l

r)

party.

Required By Law. “Required by Law” means an activity which Business Associate is required to do
or perform based on the provisions of state and/or federal law.

Secretary. “Secretary” means the Secretary of the Department of Health and Human Services or
the Secretary’s designee.

Security Incident. “Security Incident” means the attempted or successful unauthorized access,
use, disclosure, modification, or destruction of information or interference with the system
operations in an infarmation system.

Underlying Agreement. “Underlying Agreement” means the County contract for goods or services

made through the County’s procurement office which the parties have entered into and which
the County has determined requires the execution of this Business Associate Agreement,

Unsecured Protected Health Information. “Unsecured Protected Health Information” means
protected health information that is not rendered unusable, unreadable, or indecipherable to
unauthorized persons through the use of a technology or methodology approved by the
Secretary.

QObligations and Activities of Business Associate

a}

b)

c)

d)

Business Associate acknowledges and agrees that it is obligated by law (or upon the effective
date of any portion thereof shall be obligated) to meet the applicable provisions of HIPAA and
such provisions are incorporated herein and made a part of this Business Associate Agreement.
Covered Entity and Business Associate agree that any regulations and/or guidance issued by
DHHS with respect to HIPAA that relate to the obligations of business associates shall be deemed
incorporated into and made a part of this Business Associate Agreement.

In accordance with 45 CFR §164.502(a)(3}), Business Associate agrees not to use or disclose PHI
other than as permitted or required by this Business Associate Agreement or as Required by Law.

Business Asscciate agrees to develop, implement, maintain and use appropriate administrative,
technical, and physical safeguards that reasonably prevent the use or disclosure of PHI other than
as provided for by this Business Associate Agreement, in accordance with 45 CFR §5164.306, 310
and 312. Business Associate agrees to develop, implement, maintain and use administrative,
physical, and technical safeguards that reasonably and appropriately protect the confidentiality,
integrity, and availability of Electronic PHI, in accordance with 45 CFR §§164.306, 308, 310, and
312. In accordance with 45 CFR §164.316, Business Associate shall also develop and implement
policies and procedures and meet the documentation requirements as and at such time as may
be required by HIPAA.

Business Associate agrees ta mitigate, to the extent practicable, any harmful effect that is known
to Business Associate, of a use or disclosure of PHI by Business Associate in violation of the
requirements of this Business Associate Agreement.
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e

f)

g)

h)

j)

k)

In accordance with 45 CFR §§164.308, 314 and 502, Business Associate will ensure that any
workforce member or agent, including a vendor or subcontractor, whom Business Associate
engages to create, receive, maintain, or transmit PH! on Business Associate’s behalf, agrees to the
same restrictions and conditions that apply through this Business Associate Agreement to
Business Associate with respect to such information, including minimum necessary limitations.
Business Associate will ensure that any workforce member or agent, including a vendor or
subcontractor, whom Business Associate engages to create, receive, maintain, or transmit PHI on
Business Associate’s behalf, agrees to impiement reasonable and appropriate safeguards to
ensure the confidentiality, integrity, and availability of the PHI.

At the request of Covered Entity, Business Associate will provide Covered Entity, or as directed by
Covered Entity, an Individual, access to PHI maintained in a Designated Record Set in a time and
manner that is sufficient to meet the requirements of 45 CFR § 164.524, and, where required by
HIPAA, shall make such information available in an electronic format where directed by the
Covered Entity.

At the written request of Covered Entity, (or if so directed by Covered Entity, at the written
request of an Individua!), Business Associate agrees to make any amendment to PHI in a
Designated Record Set, in a time and manner that is sufficient to meet the requirements of 45
CFR § 164.526.

In accordance with 45 CFR §164.504(e)(2), Business Associate agrees to make its internal
practices, books, and records, including policies and procedures, and any PHI, relating to the use
and disclosure of PHI, available to Covered Entity or to the Secretary for purposes of determining
compliance with applicable law. To the extent permitted by law, said disclosures shall be held in
strictest confidence by the Covered Entity. Business Associate will provide such access in a time
and manner that is sufficient to meet any applicable requirements of applicable law.

Business Associate agrees to document and maintain a record of disclosures of PHI and
information related to such disclosures, including the date, recipient and purpose of such
disclosures, in a manner that is sufficient for Covered Entity or Business Associate to respond to a
request by Covered Entity or an Individual for an Accounting of disclosures of PHI and in
accordance with 45 CFR § 164.528. Business Associate further shall provide any additional
information where required by HIPAA and any implementing regulations. Unless otherwise
provided under HIPAA, Business Asscciate will maintain the Accounting with respect to each
disclosure for at least six years following the date of the disclosure.

Business Associate agrees to provide to Covered Entity upon written request, or, as directed by
Covered Entity, to an Individual, an Accounting of disclosures in a time and manner that is
sufficient to meet the requirements of HIPAA, in accordance with 45 CFR §164.528. In addition,
where Business Associate is contacted directly by an Individual based upon information provided
to the Individual by Covered Entity and where so required by HIPAA and/or any implementing
regulations, Business Associate shall make such Accounting available directly to the Individual.

In accordance with 45 CFR §164.502{b), Business Associate agrees to make reasonable efforts to
fimit use, disclosure, and/or requests for PHI to the minimum necessary to accomplish the
intended purpose of the use, disclosure, or request. Where required by HIPAA, Business
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Associate shall determine (in its reascnable judgment) what constitutes the minimum necessary
to accomplish the intended purpose of a disclosure.

In accordance with 45 CFR §502(a}(5), Business Associate shall not directly or indirectly receive
remuneration in exchange for any PHI of an Individual, except with the express written pre-
approval of Covered Entity.

m) To the extent Business Associate is to carry out ane or more obligation(s) of the Covered Entity’s

p)

under Subpart E of 45 CFR Part 164, Business Associate shall comply with the requirements of
Subpart E that apply to the Covered Entity in the performance of such obligationis).

In accordance with 45 CFR §164.314(a)(1)(i}{C), Business Associate agrees to promptly report to
Covered Entity any Security Incident of which Business Associate becomes aware.

In accordance with 45 CFR §164.410 and the provisions of this Business Associate Agreement,
Business Associate will report to Covered Entity, following Discovery and without unreasonable
delay, but in no event later than five business days following Discovery, any Breach of Unsecured
Protected Health Information. Business Associate shall cooperate with Covered Entity in
investigating the Breach and in meeting Covered Entity's obligations under HIPAA and any other
applicable security breach notification laws, including, but not limited to, providing Covered
Entity with such information in addition to Business Associate’s report as Covered Entity may
reasonably request, e.g., for purposes of Covered Entity making an assessment as to
whether/what Breach Notification is required.

Business Associate’s report under this subsection shall, to the extent available at the time the
initial report is required, or as promptly thereafter as such information becomes available but no
later than 30 days from discovery, include:

1. The identification (if known} of each Individual whose Unsecured Protected Health
Information has been, or is reasonably believed by Business Associate to have been,
accessed, acquired, or disclosed during such Breach;

2. A description of the nature of the unauthorized acquisition, access, use, or
disclosure, including the date of the Breach and the date of discovery of the Breach;

3. A description of the type of Unsecured PHI acquired, accessed, used or disclosed in
the Breach (e.g., full name, Social Security number, date of birth, etc.);

4. The identity of the individual(s) who made and who received the unauthorized
acquisition, access, use or disclosure;

5. A description of what Business Associate is doing to investigate the Breach, to
mitigate losses, and to protect against any further breaches; and

6. Contact information for Business Associate’s representatives knowledgeable about
the Breach.

Business Associate shall maintain for a period of six years all information required to be
reported under paragraph "o". This records retention requirement does not in any manner
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change the obligation to timely disclose all required information relating to a non-permitted
acquisition, access, use or disclosure of Protected Health Information to the County Privacy
Officer and the County Project Officer or designee five business days following Discovery.

3) Permitted Uses and Disclosures by Business Associate
Except as otherwise limited in this Business Associate Agreement, Business Associate may use or

disclose PHI, consistent with HIPAA, as follows:

4)

a)

b}

d)

Business Associate may use or disclose PHI as necessary to perform functions, activities, or
services to or on behalf of Covered Entity under any service agreement(s) with Covered Entity,
including Data Aggregation services related to the health care operations of Covered Entity, if
called for in the Underlying Agreement, if Business Associate's use or disclosure of PHI would not
violate HIPAA if done by Covered Entity.

Business Associate may use PHI for the proper management and administration of Business
Associate or to carry out the legal responsibilities of Business Associate.

Business Associate may disclose PHI for the proper management and administration of Business
Associate if:

1. Disclosure is Required by Law;

2. Business Associate obtains reasonable assurances from the person to whom the PHI is
disclosed that the PHI will remain confidential, and will be used or further disclosed only
as Required by Law or for the purpose for which it was disclosed, and the person agrees
to promptly notify Business Associate of any known breaches of the PHI's confidentiality;
or

3. Disclosure is pursuant to an order of a Court or Agency having jurisdiction over said
information.

Business Associate may use PHI to report violations of law to appropriate Federal and State
authorities, consistent with 45 CFR § 164.502(j){1).

Obligations of Covered Entity

a)

b)

Covered Entity will notify Business Associate of any limitations on uses or disclosures described in
its Notice of Privacy Practices (NQPP).

Covered Entity will notify Business Associate of any changes in, or revocation of, permission by an
Individual to use or disclose PHI, to the extent that such changes or revocation may affect
Business Associate's use or disclosure of PHI.

Covered Entity will notify Business Associate of any restriction of the use or disclosure of PHI, to

the extent that such restriction may affect Business Associate’s use or disclosure of PHI.
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5)

d)

e)

Covered Entity will notify Business Associate of any alternative means or locations for receipt of
communications by an Individual which must be accommodated or permitted by Covered Entity,
to the extent that such alternative means or locations may affect Business Associate’s use or
disclosure of PHI.

Except as otherwise provided in this Business Associate Agreement, Covered Entity will not ask
Business Associate to use or disclose PHI in any manner that would not be permissible under
HIPAA if such use and/or disclosure was made by Covered Entity.

Term, Termination and Breach

a)

b)

c)

d)

e

This Business Associate Agreement is effective when fully executed and will terminate when all of
the PHI provided by Covered Entity to Business Associate, or created or received by Business
Associate on behalf of Covered Entity, is destroyed or returned to Covered Entity, including any
material provided to subcontractors. If it is infeasible to return or destroy all PHI, protections are
extended to such information, in accordance with the Section 5(d) and 5(e) below.

Upon Covered Entity’s determination that Business Associate has committed a violation or
material breach of this Business Associate Agreement, and in Covered Entity's sole discretion,
Covered Entity may take any one or more of the following steps:

1. Provide an opportunity for Business Associate to cure the breach or end the violation,
and if Business Associate does not cure the Breach or end the violation within a
reasonable time specified by Covered Entity, terminate this Business Associate
Agreement;

2. Immediately terminate this Business Associate Agreement if Business Associate has
committed a material breach of this Business Associate Agreement and cure of the
material breach is not feasible; or,

3. If neither termination nor cure is feasible, elect to continue this Business Associate
Agreement and report the violation or material breach to the Secretary.

If Business Associate believes Covered Entity has failed to fulfill any of its duties under this
Business Associate Agreement, Business Associate will promptly notify Covered Entity as to same
and Covered Entity shall promptly address the matter with Business Associate.

Except as provided in Section 5(e) upon termination of this Business Associate Agreement for any
reason, Business Associate will return or destroy, at the discretion of Covered Entity, all PH!
received from Covered Entity or created or received by Business Associate on behaif of Covered
Entity. This provision will also apply to PHI that is in the possession of workforce members,
subcontractors, or agents of Business Associate. Neither Business Associate, nor any workforce
member, subcontractor, or agent of Business Associate, will retain copies of the PHI.

If Business Associate determines that returning or destroying all or part of the PHI received or

created by and/or on behalf of Covered Entity is not feasible, Business Associate will notify

Covered Entity of the circumstances making return or destruction infeasible. If Covered Entity

agrees that return or destruction is infeasible, then Business Associate will extend the protections
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of this Business Associate Agreement to such PHI and limit further uses and disclosures of such
PHI to those purposes that make the return or destruction infeasible, for so long as Business
Associate maintains such PHI. Business Associate further agrees to retain the minimum necessary
PHI to accomplish those tasks/responsibilities which make return and/or destruction infeasible.

6} Miscellaneous

a)

b)

d)

Covered Entity and Business Associate agree to take any action necessary to amend this Business
Associate Agreement from time to time as may be necessary for Covered Entity or Business
Associate to comply with the requirements of HIPAA, and/or any other implementing regulations
or guidance.

Notwithstanding the expiration or termination of this Business Associate Agreement or any
Underlying Agreement, it is acknowledged and agreed that those rights and obligations of
Business Associate which by their nature are intended to survive such expiration or termination
shall survive, including, but not limited to, Sections 5(d) and 5(e) herein.

In the event the terms of this Business Associate Agreement conflict with the terms of any other
agreement between Covered Entity and Business Associate or the Underlying Agreement, then
the terms of this Business Associate Agreement shall control.

Notices and requests provided for under this Business Associate Agreement will be made in writing to
Covered Entity, delivered by hand-delivery, overnight mail or first class mail, postage prepaid at:

(1) Marcy Foster,

Arlington County DHS Privacy Officer
2100 Clarendon Blvd., Suite 511
Arlington, Virginia 22201

(2) Stephen Maclsaac

County Attorney

2100 Clarendon Blvd., Suite 511
Arlington, Virginia 22201

{3) County Project Officer

Chris Green

Information Systems Bureau Chief
2100 Washington Blvd.

Arlington, Virginia 22204

Notice and requests provided for under this Business Associate Agreement will be made in
writing in the manner described above to Business Asscciate at:

Welligent

Attn: John McCraw

5205 Colley Avenue

Norfolk, Virginia 23508
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f)

g

h)

)

k)

Covered Entity will have the right to inspect any records of Business Associate or to audit
Business Associate to determine whether Business Associate is in compliance with the terms of
this Business Associate Agreement. However, this provision does not create any obligation on the
part of Covered Entity to conduct any inspection or audit.

Nothing in this Business Associate Agreement shall be construed to create a partnership, joint
venture, or other joint business relationship between the parties or any of their affiliates, or a
relationship of employer and employee between the parties. Rather, it is the intention of the
parties that Business Associate shall be an independent contractor.

Nothing in this Business Associate Agreement provides or is intended to provide any benefit to
any third party.

The Business Associate will indemnify and hold harmless Arlington County, its elected officials,
officers, directors, employees and/or agents from and against any employee, federal
administrative action or third party claim or liability, including attorneys’ fees and costs, arising
out of or in connection with the Business Associate’s violation {or alleged violation) and/or any
violation and/or alleged violation by Business Associate's workforce, agent/s, or subcontractor/s
of the terms of this Business Associate Agreement, federal law, HIPAA, the HITECH Act, and/or
other implementing regulations or guidance or any associated audit or investigation.

The obligation to provide indemnification under this Business Associate Agreement shall be
contingent upon the party seeking indemnification providing the indemnifying party with written
notice of any claim for which indemnification is sought. Any limitation of liability provisions
contained in the Underlying Agreement do not supersede, pre-empt, or nullify this provision or
the Business Associate Agreement generally.

This indemnification shall survive the expiration or termination of this Business Associate
Agreement or the Underlying Agreement.

Any ambiguity in this Business Associate Agreement shall be resolved to permit the parties to
comply with HIPAA, its implementing regulations, and associated guidance. The sections,
paragraphs, sentences, clauses and phrases of this Business Associate agreement are severable. If
any phrase, clause, sentence, paragraph or section of this Business Associate Agreement is
declared invalid by a court of competent jurisdiction, such invalidity shall not affect any of the
remaining phrases, clauses, sentences and sections of this Business Associate Agreement.

If any dispute or claim arises between the parties with respect to this Business Associate
Agreement, the parties will make a good faith effort to resolve such matters informally, it being
the intention of the parties to reasonably cooperate with each other in the performance of the
obligations set forth in this Business Associate Agreement. The Dispute Resolution clause of the
Underlying Agreement ultimately governs if good faith efforts are unsuccessful.

A waiver with respect to one event shall not be construed as continuing, or as a bar to or waiver
of any other right or remedy as to any subsequent events.

Neither party may assign any of its rights or obligations under this Business Associate Agreement
without the prior written consent of the other party.
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m) This Business Associate Agreement and the rights and obligations of the parties hereunder shall

o)

p)

a)

be construed, interpreted, and enforced with, and shall be governed by, the laws of the
Commonwealth of Virginia and the United States of America.

This Business Associate Agreement shall remain in effect for the duration of the Underlying
Agreement between the parties, any renewals, extension or continuations thereof, and until such
time as all PHI in the possession or control of the Business Associate has been returned to the
Covered Entity and/or destroyed. If such return or destruction is not feasible, the Business
Associate shall use such PHI only for such limited purposes that make such return or destruction
not feasible and the provision of this Business Associate Agreement shall survive with respect to
such PHI.

The Business Associate shall be deemed to be in violation of this Business Associate Agreement if
it knew of, or with the exercise of reasonable diligence or oversight should have known of, a
pattern of activity or practice of any subcontractor, subsidiary, affiliate, agent or workforce
member that constitutes a material violation of that entity's obligations in regard to PHI unless
the Business Associate took prompt and reasonable steps to cure the breach or end the violation,
as applicable, and if such steps were unsuccessful, terminated the contract or arrangement with
such entity, if feasible.

Upon the enactment of any law or regulation affecting the use or disclosure of PHI, or any change
in applicable federal law including revisions to HIPAA; upon publication of any decision of a court
of the United States or of the Commonwealth of Virginia, relating to PHI or applicable federal law;
upon the publication of any interpretive policy or opinion of any governmental agency charged
with the enforcement of PHI disclosures or applicable federal law, the County reserves the right,
upon written notice to the Business Associate, to amend this Business Associate Agreement as
the County determines is necessary to comply with such change, law or regulation. If the Business
Associate disagrees with any such amendment, it shall so notify the County in writing within thirty
(30) days of the County’s notice. In case of disagreement, the parties agree to negotiate in good
faith the appropriate amendment(s) to give effect to such revised obligation. In the County’s
discretion, the failure to enter into an amendment shall be deemed to be a default and good
cause for termination of the Underlying Agreement.

The County makes no warranty or representation that compliance by the Business Associate with
this Business Associate Agreement, HIPAA, the HITECH Act, federal law or the regulations
promulgated thereunder will be adequate or satisfactory for the Business Associate’s own
purposes or to ensure its compliance with the above. The Business Associate is solely responsible
for all decisions made by it, its workforce members, agents, employees, subsidiaries and
subcontractors regarding the safeguarding of PHI and compliance with federal law.

r} The Business Associate agrees that its workforce members, agents, employees, subsidiaries and

s}

subcontractors shall be bound by the confidentiality requirements herein and the provisions of
this Business Associate Agreement shall be incorporated into any training or contracts with the
Same,

This Business Associate Agreement may be executed in one or more counterparts, each of which
shall be deemed an original, but all of which together shall constitute one and the same
document.
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t) This Business Associate Agreement shall replace and supersede any prior Business Associate

Agreement entered between the parties.

IN WITNESS WHEREOF, each party hereto has executed this Business Associate Agreement in duplicate

originals on the date below written:

Arlington County, Virginia
—
By: JYih bi S

{Signature)

Name:  \1arey Foster

Title:
LS County Privacy Officer

Date: ”——! 1 !1m—\

Business Associate

By: MMCMW)

(Yignature)
Name: MY MC U'OLVJ
Title: 'P‘res ‘a e,v\..k
Date: \2(’;\-/2[5('3(-
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ATTACHMENT D

NONDISCLOSURE AND DATA SECURITY AGREEMENT
(CONTRACTOR)

The undersigned, an authorized agent of the Contractor and on behalf of Welligent (“Contractor”),
hereby agrees that the Contractor will hold County-provided information, documents, data, images,
records and the like confidential and secure and protect them against loss, misuse, alteration, destruction
or disclosure. This includes, but is not limited to, the information of the County, its employees,
contractors, residents, clients, patients, taxpayers and property as well as information that the County
shares with the Contractor for testing, support, conversion or other services provided under Arlington
County Agreement No. 17-165-RFP (the “Project” or “Main Agreement”) or that may be accessed through
other County-owned or -controlled databases (all of the above collectively referred to as “County
Information” or “Information”).

In addition to the DATA SECURITY obligations set in the County Agreement, the Contractor agrees that it
will maintain the privacy and security of County Information, control and limit internal access and
authorization for access to such Information and not divulge or allow or facilitate access to County
Information for any purpose or by anyone unless expressly authorized. This includes, but is not limited to,
any County Information that in any manner describes, locates or indexes anything about an individual,
including, but not limited to, his/her (“his”) Personal Health Information, treatment, disability, services
eligibility, services provided, investigations, real or personal property holdings and his education, financial
transactions, medical history, ancestry, religion, political ideology, criminal or employment record, social
security number, tax status or payments, date of birth, address, phone number or anything that affords a
basis for inferring personal characteristics, such as finger and voice prints, photographs, or things done by
or to such individual, or the record of his presence, registration, or membership in an organization or
activity, or admission to an institution.

Contractor also agrees that it will not directly or indirectly use or facilitate the use or dissemination of
County information (whether intentionally or by inadvertence, negligence or omission and whether
verbally, electronically, through paper transmission or otherwise) for any purpose other than that directly
associated with its work under the Project. The Contractor acknowledges that any unauthorized use,
dissemination or disclosure of County Information is prohibited and may also constitute a violation of
Virginia or federal laws, subjecting it or its employees to civil and/or criminal penalties.

Contractor agrees that it will not divulge or otherwise facilitate the disclosure, dissemination or access to
or by any unauthorized person, for any purpose, of any Information obtained directly, or indirectly, as a
result of its work on the Project. The Contractor shall coordinate closely with the County Project Officer to
ensure that its authorization to its employees or approved subcontractors is appropriate and tightly
controlled and that such person/s also maintain the security and privacy of County Information and the
integrity of County-networked resources.

Contractor agrees to take strict security measures to ensure that County Information is kept secure; is
properly stored in accordance with industry best practices, and if stored is encrypted as appropriate; and
is otherwise protected from retrieval or access by unauthorized persons or for unauthorized purposes.
Any device or media on which County Information is stored, even temporarily, will have strict security and
access control. Any County Information that is accessible will not leave Contractor’s work site or the
County’s physical facility, if the Contractor is working onsite, without written authorization of the County
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Project Officer. If remote access or other media storage is authorized, the Contractor is responsible for
the security of such storage device or paper files.

Contractor will ensure that any laptops, PDAs, netbooks, tablets, thumb drives or other media storage
devices, as approved by the County and connected to the County network, are secure and free of all
computer viruses, or running the latest version of an industry-standard virus protection program. The
Contractor will ensure that all passwords used by its employees or subcontractors are robust, protected
and not shared. The Contractor will not download any County information except as agreed to by the
parties and then only onto a County-approved device. The Contractor understands that downloading
onto a personally owned device or service, such as personal e-mail, Dropbox, etc., is prohibited.

Contractor agrees that it will notify the County Project Officer immediately upon discovery or becoming
aware or suspicious of any unauthorized disclosure of County Information, security breach, hacking or
other breach of this agreement, the County’s or Contractor’s security policies, or any other breach of
Project protocols concerning data security or County Information. The Contractor will fully cooperate with
the County to regain possession of any Information and to prevent its further disclosure, use or

dissemination. The Contractor also agrees to promptly notify others of a suspected or actual breach if
requested.

The Contractor agrees that all duties and obligations enumerated in this Agreement also extend to its
employees, agents or subcontractors who are given access to County information. Breach of any of the
above conditions by Contractor’'s employees, agents or subcontractors shall be treated as a breach by the
Contractor. The Contractor agrees that it shall take all reasonable measures to ensure that its employees,
agents and subcontractors are aware of and abide by the terms and conditions of this agreement and
related data security provisions in the Main Agreement.

It is the intent of this NonDisclosure and Data Security Agreement to ensure that the Contractor has the
highest level of administrative safeguards, disaster recovery and best practices in place to ensure
confidentiality, protection, privacy and security of County information and County-networked resources
and 1o ensure compliance with all applicable local, state and federal laws or regulatory requirements.
Therefore, to the extent that this NonDisclosure and Data Security Agreement conflicts with the Main
Agreement or with any applicable local, state, or federal law, regulation or provision, the more stringent
requirement, law, regulation or provision controls.

At the conclusion of the Project, the Contractor agrees to return all County Information to the County

Project Officer. These obligations remain in full force and effect throughout the Project and shall survive
any termination of the Main Agreement.

Authorized Signature: Xﬁ‘ W\(OLQ,. AJ

Printed Name and Title: @V\d\(/ W\C(- \(‘au,d } \D ML fﬁ\ 6\’\‘&
Date: lz/‘}fzol?

TO BE COMPLETED PRIOR TO BEGINNING WORK ON THE PROJECT
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ATTACHMENT E

DEFINITIONS

“Acceptance Procedures” Any Software, Hardware, System and/or Upgrade furnished by Contractor shall
be subject to Pre-Delivery Testing, Acceptance Testing, Interim Acceptance Testing and Final Acceptance

“Authorized Users” County’s authorized employees, volunteers, trainees and agents

“Certified EHR" shall mean the electronic health record that has been certified to meet the requirements
of American Recovery and Reinvestment Act of 2009, and any updated regulations issued thereunder, by
the Office of National Coordinator for Health Information Technology designated Authorized Certification
and Testing Body, or its successor.

“Concurrent Users” shall mean the number of simultaneous properly Named Users that may
access the Licensed Program at any given moment in time

"Continuously Subscribes” shall mean continuous subscription, without interruption, to the
Software Services while paying all expenses and fees not otherwise disputed in good faith and in
a timely manner.

“Customizations” shall mean software program(s) developed by Contractor to meet special requirements
of the County that are not part of the Licensed Program. Customizations may be embedded into the
Licensed Program, may interface with the Licensed Program or operate independently from the Licensed
Program.

Default. “Default” means:

. a party's material breach of any of its obligations hereunder which is not cured within
thirty (30) days after receiving written notice of such default from the other party, or the
Licensed Program failing the Acceptance Procedures;

" the dissolution of a party;

] a party has a receiver, trustee, custodian, or similar agent appointed to or take
possession of any of its property or business;

= a party ceases to operate business in the ordinary course for more than ten {10)
consecutive days;

. a party files or has filed against it a petition (or other document) under any bankruptcy
law or similar law that has not been dismissed within ninety (90) calendar days after the
filing of such petition (or document);

. a party undergoes any dissolution, liquidation, composition, financial reorganization, or
recapitalization with creditors and such action impairs the party’s ability to perform
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under this Agreement; or,
a party makes a general assignment or trust mortgage for the benefit of its creditors

a party becomes insolvent or unable to pay its debts as they come due;

Contractor (i) persistently or repeatedly refuses or fails to supply sufficient, properly
skilled Contractor Representatives so long as Licensee has reasonably communicated
with Contractor regarding any deficiencies in performance of said representatives, or (ii)
fails to comply with applicable laws, ordinances, rules or regulations which have a
material impact upon the business of Licensee, the grant of rights herein, or the
performance of the Licensed Program;

Contractor’s Licensed Program fails to achieve and keep current with ONC-ATCB ARRA
ambulatory certification requirements and standards for the Licensed Program modules
identified on Attachment F within the time frames required by ONC-ATCB;

Contractor fails to conduct Project Impiementation Kickoff within ten (10) business days
of the date agree to by all parties in Attachment G due to the sole fault of Contractor;

The hardware, software and/or system, or other deliverable supplied by Contractor
including any third-party software utilized by Contractor in order to meet the Licensed
Program functionality requirements and the hardware, software or system, fails to
successfully complete Acceptance Procedure(s} pursuant to Attachment G, Acceptance
Testing in this Agreement.

A breach by Contractor of its obligations under the Business Associate Agreement, as

referenced in Attachment C.
= A failure by County to pay undisputed fees as prescribed herein.

“Defect” shall mean any non-conformity to system Specifications, including scope documentation
in Appendix A, such as the Functionality Matrix , erroneous data applied to the databases,
materially decreased performance in the processing of transactions, or reporting that prevents
or impairs a feature of the Software, the Welligent System or Software Service from materially
performing in accordance with the Documentation and Specifications and/or the Welligent
Implementation Requirements in the Welligent System and failures of the Software, the
Welligent System, or the Software Service to perform in accordance with the Service Level
Requirements and with the functionality described in the Documentation and Specifications
and/or the Welligent Implementation Reqguirements.

“Documentation and Specifications” shall mean the Contractor System documentation and
capabilities, training materials and release notes related to system enhancements and updates.

“Enhancements” shall mean standard revisions made by Contractor, and provided free of charge,
to improve the functionality of the Contractor System and/or Software and/for Software Service
which are generally made available to all Customers of Contractor. Contractor shall own all right,
title and interest in and to any and all Enhancements developed by Contractor. This shall include
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all improvements, discoveries, inventions, innovations, variations, developments, modifications,
technology, know-how, and other information, of any nature or form, discovered, developed or
conceived by Welligent or for the County which relate to the Welligent System, Software Service

or Welligent Intellectual Property as in existence on the date of this Agreement or at any time
hereafter.

“Go-Live” shall mean the first date that the Licensed Program modules selected by County are all
in use by County in a “live” production environment by at least 20% of named users with real
patient data.

“Implementation Plan” shall mean an implementation schedule and plan that is agreed upon
between Contractor and the County.

"Individually Identifiable Health Information” shall mean information that is a subset of health
information, including demographic information collected from an individual, and (i} is created or
received by a health care provider, health plan, employer, or health care clearinghouse; and {ii)
relates to the past, present, or future physical or mental health or condition of an individual; the
provision of health care to an individual; or the past, present or future payment for the provision
of health care to an individual; and (a) identifies the individual, or (b) with respect to which there
is a reasonable basis to believe the information can be used to identify the individual.

“Installation Date” shall mean the date upon which the Contractor System is initially installed, available to
County, and tested to prove basic functioning.

“Kickoff Date” shall mean the date upon which Contractor and County meet in person to officially begin
the software implementation.

“Maintenance Services” shall mean the support / maintenance services described on the attached
Attachment K.

“Named Users” shall mean the number of users who are authorized to access the Licensed Program.

“Network/Software Downtime” is defined as an inability to transmit and receive data caused by failure of
Contractor’'s network or software, excluding Maintenance.

“Privacy Regulations” shall mean the Standard for Privacy of Individually Identifiable Health
Information, 45 C.F.R. Parts 160 and 164.

“Project Milestones” shall mean the deadlines for completion of certain defined goals for Implementation of
the Licensed Program as set forth in Attachment G.

“Release” scheduled Software releases which provide significant new functionality or capability of
the Software relative to the prior version

“Security Regulations” shall mean the Health Insurance Reform: Security Standards, 45 C.F.R.
Parts 160, 162, 164.

“SLA Violation” is the failure of Contractor to meet the Performance Standards in Attachment H for

Page 42 of 74



responding to program defects ("Defects” as defined above). In the event Contractor fails to respond and
remediate Errors as provided in this Attachment and the failure to respond and remediate continues for
48 hours after written notice from Licensee, then Contractor agrees to pay a penalty of $500.00 per full
business day of SLA Violations for as long as the SLA Violation continues until the maximum penalty
amount is attained. The maximum penalty incurred in a calendar year shall not exceed 25% of the Annual
Maintenance Fee per calendar year. Before the penalty accrues, Licensee will follow the Error reporting
procedures incorporated as a part of the Performance Standards or other reasonable reporting
requirements adopted by Contractor to assure the Errors are accurately reported and reproducible.
Contractor will have 48 hours from the Licensee’s written notice to Contractor that it has followed the
error reporting procedures and of Contractor’s failure to follow the Performance Standards before any
penalty commences.”

“Software” shall mean certain proprietary software, data bases, enhancements and updates, as
well as third party integrations, services and networks including Welligent Systems.

“Software Service” shall mean Contractor will provide to County access to and use of the
Welligent Systems, as hosted by Contractor and made available to County on the Internet.

“Soft-Launch” shall mean a County decision to utilize the Software in parallel with its current
Electronic Health Record for the purposes of manually entering data prior to actually switching
EHRs. The County expects the Software to be ready for Go-Live, but for a period (e.g., one month)
would still record and bill services in the existing EHR while manually building new appointment
schedules and treatments plans (as examples) in the Software. The impact - seen in Attachment
G — is that billing and final Go-Live sign-off would be delayed by the Soft-Launch period. The
Software would otherwise have been approved for Go-Live.

"Source Code Escrow” If requested by the County, the Contractor shall deposit the Source Code,
Object Code and Documentation and Specifications for the Software, including, any
modifications, upgrades or amendments thereof, pursuant to the terms of the Contractor's
Source Code Escrow Agreement with its then-current source code escrow provider. In the event
the County makes such a request, County must execute such documentation as is reasonably
necessary and may be required by the Contractor and/or such provider. The County will be solely
responsible for and incur all costs associated with such election and adding County as a
beneficiary of such Source Code Escrow Agreement, and such costs and fees are in addition to
amounts otherwise paid by County pursuant to this Agreement. Source Code Escrow Agreement
can be found in Attachment K - Source Code Escrow Agreement.

“Specifications” shall mean functional, performance and operational characteristics and specifications for
the Licensed Programs described in Contractor’s materials, Attachment A, the Software Design document
and for any Customization beyond those functions described in Attachment A which is described in a
Statement of Work that is mutually agreed upon by the parties.

“Updates” shall mean corrections to minor defects of the Software which are generally made
available to all Customers of Contractor.

“Welligent Security System” Contractor will continually maintain a data security management program
that includes reasonable and appropriate administrative, physical and technical safeguards to ensure the
confidentiality, integrity and availability of Customer Data as defined in this Agreement
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“Welligent Systems” shall mean the suite of health applications developed by the Contractor
including but not limited to an electronic health records system, offline applications, patient
portal, Welligent Express mobile applications, Welligent chat, Welligent Training, reporting
databases, Welligent Messenger, and Bl modules.
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ATTACHMENT F
LICENSE GRANT

Welligent System and Software Services the Contractor has developed the Welligent Systems
which can be accessed through the Contractor's website permitting data entry and providing
information management. The Welligent System includes certain proprietary software, data
bases, and enhancements and updates thereto, and third party integrations, services and
networks. Welligent System documentation and capabilities, training materials and release notes
related to system enhancements and updates are available in the Contractor's secure website,
www.welligentcommunity.com. During the Term of this Agreement, the Contractor shall provide
the County access te and use of the Welligent System, as hosted by the Contractor and made
available to the County on the Internet.

License to Use the Software Services Subject to the terms and conditions of this Agreement, the
Contractor hereby grants the County’s Authorized Users a nonexclusive, nontransferable right to
use the Software Service solely for County’s own internal business purposes. This license will
begin on the Effective Date and continue for the Term or as long as County Continuously
Subscribes, without interruption, to the Software Services and pays all fees not otherwise
disputed in good faith and expenses due to Welligent in a timely manner. This license applies to
all modules of the Welligent System, including, but not limited to, offline applications, patient
portal, Welligent chat, Welligent Training, reporting databases, and Bl modules, Including future
modules released to Welligent customers.

Enhancements and Updates Ouring the Term of this Agreement, for as long as the County
Continuously Subscribes, and provided that the County is in compliance with the terms of this
Agreement, the Contractor will provide the County with, free of charge access to all standard
revisions made by the Contractor to improve the functionality of the Welligent System and/or
Software and/or Software Service which shall be made available to the County, and all other
Welligent customers generally, and corrections to Defects of the Software shall be made
available to the County. At the request of the County, on a case by case basis, the Contractor shall
expedite Enhancements for a fee, to be agreed upon in writing by both parties based on the
specifications of the Enhancement. All enhancements must conform to data security and quality
standards outlined in this Agreement. Contractor shall own all right, title and interest in and to
any and all Enhancements developed by Contractor. This shall include all improvements,
discoveries, inventions, innovations, variations, developments, modifications, technology, know-
how, and other information, of any nature or form, discovered, developed or conceived by
Welligent or for the County which relate to the Welligent System, Software Service or Welligent
Intellectual Property as in existence on the date of this Agreement or at any time hereafter.

Source Code Escrow If requested by the County, the Contractor shall deposit the Source Code,
Object Code and Documentation and Specifications for the Software, including, any
modifications, upgrades or amendments thereof, pursuant to the terms of the Contractor's
Source Code Escrow Agreement with its then-current source code escrow provider. In the event
the County makes such a request, the County must execute such documentation as is reasonably
necessary and may be required by the Contractor and/or such provider. The County will be solely
responsible for and incur all costs associated with such election and adding the County as a
beneficiary of such Source Code Escrow Agreement, and such costs and fees are in addition to
amounts otherwise paid by the County pursuant to this Agreement. The Source Code Escrow
Agreement can be found in Attachment K - Source Code Escrow Agreement.
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5. County Use of Contractor Software After Release Event If a Release Event (as defined in the
Source Code Escrow Agreement, Attachment K) occurs and the Contractor's Software is

delivered to the County as required by the Source Code Escrow Agreement, the Contractor shall
grant the County with a non-exclusive, non-transferrable, perpetual license to install the
Contractor’s Software on County Equipment and to use the Contractor's Software, as it existed
as of the date of the Release Event, solely for the County’s own internal business purposes and
subject to the terms and conditions of this Agreement. The County shall be responsible for
providing the necessary computer equipment and networking equipment and obtaining licenses
to use third party software products (such as the Oracle® database software)} required for the
operation of the Contractor’s Software.
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ATTACHMENT G

IMPLEMENTATION PLAN AND PERSONNEL

1. CONTRACTOR’S IMPLEMENTATION TEAM

The Contractor shall conduct the design and implementation of the EHR System, and shall meet the
proposed job functions with the Contractor’s assigned staff for the proposed level of effort required for
the project. Any substitution of the Contractor’s staff requires prior approval by the County in writing and
qualifications of replacement staff should be equal or greater to the originally assigned staff {Contractor
Project Resources Attachment Q).

2. PROIJECT PLAN
The delivery of the Contractor’s System is based on a preliminary project timeline {below). While the
detailed project plan and timeline cannot be approved until following the discovery and design phases,

the County and Contractor agree that an initial go-live shall accur within an 8-12-month timeframe from
kickoff.
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Project Plan Milestones
Targeted
Date Milestone ID Project Plan item
12/1/2017 1.0 | Contract Signing
12/15/2017 2.0 | Initial Setup of Customer Sandbox Environment
12/6/2017 3.0 | Project Kickoff Complete
1/5/2018 4.0 | Project Plan Sign-off
TBD in
Project 5.1 | Functionality Set 1 Design Sign-off

Page 47 of 74



# 5.2 | Functionality Set 1 Acceptance Testing Complete
“ 6.1 | Functionality Set x Design Sign-off
i 6.2 | Functionality Set x Acceptance Testing Complete
! 7.8,9,10,11 | Reserved for up to 7 iterations
“ 12 | Report Development Complete
8 13 | Clinical Configuration Complete
" 14 | All Train the Trainer Sessions Completed Onsite
“ 15 | User Acceptance Testing Complete
“ 16 | Data Conversion Sign-off and Ready for Go-Live
“ 16.1 | County submits final data for go-live conversion
12/1/2018 17 | Go-Live Complete
Optional: County option for Soft-Launch (see Attachment E -
one month 18 | Definitions)
1/11/2019
(or one
month later
if Soft-
Launch) 19 | 30-Day Post Go-Live Sign-off (All P1/P2 issues resolved)
1/31/2019
{or one
month later
if Soft-
Launch) 20 | Successful Billing Cycle Post Go-Live

Project Deliverables

The following deliverables will be provided by the Contractor through the course of the project

[ Deliverable
| Overall Project Plan

Detailed plans for each phase
{with emphasis on iteration
phases)

! Risk Management Plan
| Monthly Status Reports

____ Description |
| Schedule synchronized to payment plan and
illustration/graphic of project intent (above)
" including in particular work expected of
County and planned functionality in each
iteration. .
Implementation Plan (functionality for each |
iteration) |
Data Conversion Plan
Test Plan (per iteration, but also to |
. coordinate with County acceptance testing)
| Training Plan |
Change Management Plan (per iteration, for
| regression testing)
Monthly update of implementation risks
Progress versus Overall Project Plan,
| identification of risk or changes.
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Training Materials See Attachment R, also includes materials
for County Trainers (the trained Trainers) as
well as materials for County interfaces (in
the Functionality Matrix and Interfaces
(Attachment P).

Final Solution Submission Letter | Attesting to the completeness of the system
to meet the project objectives, including
Contractor's testing.

Configured System See Scope of Work {Attachment A)

Design Specifications Capturing how County requirements were
implemented in stock system functionality
and configurable forms.

Report Specifications See Scope of Work [Attachment A)

Data Dictionary For the as-built Welligent system (Design
Specifications will cover how County forms
were configured)

Meeting Agendas and Minutes For organization of weekly status meetings
and design meetings and to document
decisions as understood by Welligent.

Interface Specifications Capturing how interfaces are configured

Custom Modules (as needed) Simple identification of County specific
functionality added to the Welligent system;
all such functionality is to be part of the
Welligent system.

ACCEPTANCE PROCEDURES

1.

Pre-Delivery Testing

Prior to hand-off of any Deliverable, the Contractor shall test the Deliverable and certify its
conformance with all specifications, parameters, or descriptions in the applicable Specifications.
Further, the Contractor shall test to ensure the system data or information will not be accessed,
altered or destroyed in an unauthorized manner. In connection with the delivery of each
software Deliverable, the Contractor shall provide technical personnel to demonstrate to the
County the features and functions of the software Deliverable and shall provide the County with
sufficient instructions to reasonably enable County to test the Deliverable. The Contractor
acknowledges that its failure, attributable solely to the Contractor and without any cause of the
delay attributable to an act or omission of the County, to consistently provide deliverables that
conform with specifications, parameters or descriptions constitutes a material breach of this
Agreement.

Acceptance Testing

The Contractor acknowledges that its failure, attributable solely to the Contractor and without
any cause of the delay attributable to an act or omission of the County, to meet the deadlines for
Deliverables set forth in the Implementation Plan and Personnel (Attachment G) may constitute a
material breach of this Agreement, which, if not cured within 15 days of the date of written
notice from the County of such material breach, will be grounds for termination of this
Agreement. The written notice of material breach will include the specific facts upon with such
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notice is based. The County acknowledges that delays in respanses to the Contractor requests for
input, approval or other responses may delay completion of services and intends to respond to
Contractor's request for input within 5 business days where possible.

The requirements and deliverables for the implementation and project management as defined
in Attachments (A-R} include a description of each party's tasks, including without limitation,
those relating to pre-production Acceptance and Acceptance testing, training, design work and
conversions, and corresponding timeframes for completion of tasks and the milestones for
performing those tasks. Excepting the circumstance wherein the County has received more than
five {5) Deliverables within a thirty-day period for Acceptance testing, if the County fails to
perform the Acceptance Testing within the time required below, the Deliverable shall be deemed
"accepted".

Interim Acceptance Testing

Prior to Final Acceptance Testing, any completed portion of Software {(including Milestones
identified in Implementation Plan and Personnel {Attachment G) and the mutually agreed upon
Implementation Project Plan (see ltemn 2 Project Plan, Milestone #4 above)), Hardware and/or
System furnished by Contractor shall be subject to interim acceptance testing as follows
{"Acceptance Testing"):

(a) Upon written notice from the Contractor that the Software, Hardware or System is ready for
Acceptance Testing, the County shall have the opportunity to conduct Interim Acceptance
Testing (with or without the Contractor’s support) within fifteen (15) business days to
determine whether the Software, Hardware or System conforms to the Specifications.

{b) Upon a failure of the Software, Hardware or System of such Acceptance Testing, the County
shall notify the Contractor in writing within five (S) business days after completion of said
acceptance testing and provide a specific description of the item’s failure to meet the
identified Specification(s) along with documentation that such failure has occurred, and if
the Contractor is able to reproduce the item'’s failure based upon the description given by
the County and any associated documentation the Contractor will have fifteen (15) business
days in which to correct, modify or improve the itermn which is the subject of the failed
Acceptance Testing. If the Contractor is unable to reproduce the item’s failure, the County
shall conduct additional acceptance testing as described in section (c).

(€} Upon receipt of the Contractor’s demonstration, correction, modification or improvement
of the Software, Hardware or System, the County may either accept the item or conduct
additional Acceptance Testing for a period of up to fifteen (15) business days.

{d) !f the County conducts additional Acceptance Testing and determines the Software,
Hardware or System continues to fail to conform to the Specifications, then the County at its
sole election shall have the right to pursue any or all of the following options:

i.  extend the Acceptance Testing period for an additional fifteen (15) business days, at
the conclusion of which if the County determines the Software, Hardware or System
continues to fail to conform to the Specifications then the Contractor will have
fifteen (15) business days from notice of same to resolve the non-conformities;
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i. if the failure results in a Severity 1 Error in any of the following system areas: Billing
of the top three {3) revenue producing payers , Treatment Plan documentation in
adherence to state and federal audits, Submission and acceptance of Virginia State
Reporting as outlined in the Support Policies and SLA ( Attachment H), remaining
unresolved for greater than twenty (20) business days, then the County may cancel
the License and receive a full reimbursement of all fees paid by the County, and such
refund is to be paid in full by the Contractor within 30 days , beginning with
notification of cancelation;

ili. The Contractor shall install a direct replacement of Software, Hardware and/or
Systems to meet the failure of the Acceptance Testing, within a mutually agreed
upon time frame;

iv.  The County will deliver notice of Defauit to the Contractor in accordance with the
terms of this agreement, and the Contractor shall, within 30 days of receipt of the
written notice of Default, fully reimburse the County for all fees paid by the County;
and/or

v.  pursue any other remedies at law.

{e} Software, Hardware and/or Systems which must be accepted in stages shall not be finally
accepted until final acceptance of the Software, Hardware and/or System as a whole.

Final Acceptance Period

During the period following the Installation Date, for a period of ninety {90) days following the
Go-Live Date (the “"Acceptance Period”), the County shall notify the Contractor in writing of any
instances in which the Licensed Program does not perform in accordance with the Specifications,
the Development Services, the Functionality Matrix, and any other attachment of this Agreement.
If the Contractor receives any such notification during the Acceptance Period, and is unable to
reproduce the error, the County shall retest as described in Section 3(C) above. If the Contractor
receives any such notification during the Acceptance Period, and is able to reproduce the error,
or receives evidence from the County which accurately depicts the Error in the Licensed Program
described by the County then the Contractor shall, at no additional charge to the County, correct
or modify the Licensed Software to ensure that it performs in accordance with the Specifications,
provided that:

{a) Licensed Program has been properly used by the County in accordance with the
Documentation provided by the Contractor;

(b) The County endeavors to describe clearly and specifically the nature of the suspected
errors and the circumstances in which they occur;

(c} The Contractor, using best efforts, is able to confirm the existence of the Severity 1 or
Severity 2 programming errors and has thirty (30) days from the date of notification to
correct the error; and,

{d) Neither County nor any third party (other than a Contractor Representative) has
manipulated or modified Contractor Source Code or database tables.
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(e) County processes a successful billing cycle including receipt of payment.

If, at the end of the Acceptance Period, the Licensed Program is not performing in accordance
with the Specifications and the non-performance has been the subject of a written notice as
provided herein during the Acceptance Period and the Contractor has been able to reproduce or
review evidence from the County accurately describing, the performance errors as described by
the County but is unable to provide a fix within the Acceptance Period or any extension thereof,
the County may, within ten (10) Business Days after the end of the Acceptance Period send
written notice of Default in accordance with the terms of this Agreement. If the non-performance
is not the subject of a written notice as provided herein during the Acceptance Period, then the
Contractor shall have an additional forty-five (45} days to cure the non-performance of the
Licensed Program. If, at the end of the Final Acceptance Period, the Licensed Program performs
in accordance with the Specifications, and the County signs the Post Go-Live Milestone
Acceptance, the County will pay the Post Go-Live amount(s) as identified in Attachment B. In all
cases where the Contractor is unable to reproduce the Error described by the County where
evidence of an Error has been provided by the County, then, the Contractor shall provide a
demonstration to the County’s designated representative of a successful functionality within 3
business days from when the Contractor communicated the Error is not reproducible. The County
will then conduct additional acceptance testing as described in section 3 (C) above. If, at the end
of the Final Acceptance Period {including any extensions granted by the County), the Licensed
Program fails to perform in accordance with the Specifications the County may cancel the License
for the system, and receive a full reimbursement of all fees paid by the County for the system,
and such refund is to be paid in full by the Contractor within 30 days
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ATTACHMENT H

SUPPORT POLICIES, MAINTENANCE, AND SERVICE LEVEL AGREEMENTS
CUSTOMER SUPPORT

1. CUSTOMER SUPPORT SERVICES
The Contractor shall provide the following services to the County (collectively, “County Support
Services”): (i) services to assist Authorized Users to gain access to, understand and use the
Contractor's System, Software and Software Services, (ii} clarification of the Documentation and
Specifications, (iii) guidance in operation of the Contractor’s System and Software Service, and
{iv) verification, analysis and correction of Defects or failures in the Contractor’s System and
Software Service to meet the requirements specified in this Agreement. The fees for such
Customer Support Services are as set forth in Attachment B In addition to the Customer Support
Services, the Contractor shall provide additional services at the County’s request in support of
the County’s business operations, including assistance in the maintenance of Setup, creation of
additional reports and forms, development of Enhancements requested by the County and
agreed to by the Contractor , and investigation of problems resulting in “false alarm” claims of
alleged Defects in the Welligent System or Software Service or failure of the Welligent System or
Software Service to perform in accordance with the Documentation and Specifications, ar the
Contractor’s Implementation Requirements, or Service Level Requirements {“Billable Customer
Support Services”), at the Project Management Professional Services rates specified in
Attachment B.

2. SUPPORT CONTACTS
The County shall appoint up to two (2) contacts to receive technical support from the Contractor
on behalf of the County’s {"Support Contacts"). The County will identify the Support Contacts for
the Contractor and the County will appoint replacement representatives upon notice to the
Contractor. The County acknowledges that the Contractor is not obligated to provide {echnical
support other than to the County’s identified Support Contacts.

3. REGULAR HOURS FOR SUPPORT SERVICES
The Contractor’s regular hours for the provision of customer support services are 8:30 AM - 9:00
PM Eastern Time, Monday through Friday, excluding holidays (“Regular Hours”). In the event the
County requires Customer Support Services outside of Regular Hours, the County may telephone
or email as follows: 888-317-5960, support@welligent.com.

4. MULTIPLE ENVIRONMENTS
The Contractor, at no additional cost to the County, shall provide three environments to the
County and one reporting database. One LIVE environment, which will be subject to the Service
Level Requirements below, and which shall contain County-specific Data and system
configurations which have been released from the Testing environment. One Testing
environment, for reviewing the latest patches and updates before they are moved to the LIVE
enviranment on a regular, quarterly basis. One Training environment for teaching staff how to
use the system. Training environment will be updated by the Contractor {o correspond to the
LIVE environment on a regular, quarterly basis, when the Contractor updates the LIVE
environment. Following each quarterly update of the Training environment, the Contractor will
recreate County-specific test cases based on County test case configurations. The Testing
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environment shall be used by the County to build and test system configurations prior to release
to the LIVE environment. Contractor shall work with the County to develop a schedule and
process for migrating system configurations into the LIVE environment, no more frequently than
monthly. The Testing and Training environments will be available during normal County business
hours, Monday through Saturday, excluding holidays and scheduled times for patches and
updates. The Training environment shall conform to generally accepted industry standards for
system up-time and responsiveness for non-praduction information systems.

The Contractor shall also create a reporting database in the Contractor's server cloud for
customer’s private use (Reporting). Once created, this environment will contain all production
Customer Data and Protected Health Information (PH1). Daily, this reporting environment shall be
synchronized with data contained in the County’s production application environment on a 15-
minute basis. The County will be able to access this environment via VPN/ODBC using County-
provided third-party reporting tool.

5.  SERVICE LEVEL REQUIREMENTS

a. System Availability
The Contractor shall make the Software Service, as described herein, available to the County on a
24 x 7 basis, exclusive of Scheduled Downtime (as defined below) and Force Majeure Events (as
defined in Section 16 below). The County will have access to Software Service and the County
Data at least 99.9% uptime, as measured monthly, excluding Scheduled Downtime, with no
outages (unscheduled downtime) in excess of a total of one and one-half (1.5) hours in any
month. The Contractor shall notify the County by email to the Support Contacts within two hours
of any known and verified unscheduled downtime of the Software Service, and provide status
updates periodically until the Software Services are restored. The Contractor will notify the
County by email to the Support Contacts when the Software Service is restored. “Scheduled
Downtime” shall mean a maximum of any four (4) consecutive hours between Friday at 9:00 p.m.
and Sunday at 11:59 p.m., EST, unless upon two (2) days prior written notice by Welligent to
Customer of a longer time period.

b. System Maintenance

From time to time the Contractor will be required to interrupt the Software Service for
maintenance purposes. The Contractor shall use commercially reasonable efforts to conduct all
such maintenance during Scheduled Downtime, which shall mean a maximum of any four (4)
consecutive hours between Friday at 9:00 p.m. and Sunday at 11:59 p.m. EST, unless upon two
{2) business days’ prior notice by the Contractor to the County of a longer time period. The
Contract shall use commercially reasonable efforts to provide the County with notice for any
other interruption in the Software Service. Notices of Scheduled Downtime and other
interruptions will be posted on the Contractor’s website and/or Contractor’'s secure website,
www.welligentcommunity.com, and the County shall also be notified by e-mail within two (2}
business days. The Contractor shall coordinate with the County to establish the best possible time
for such interruptions within the times above due to the County operation of a 7 x 24 Emergency
Services service. Defects introduced by the system maintenance shall be considered Priority Level
1 obligations as per below.

c. System Updates

The Contractor shall issue regular, quarterly system updates to address enhancements to the

system or fix reported defects. The Contractor will initially apply all updates to the County’ TEST
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environment so that the County can review and test the latest update. The County will have 10
business days to test any updates and report issues prior to moving the update into the LIVE
environment. The Contractor will not move any County-specific enhancements or updates into
LIVE without approval from the County. To the greatest extent possible, Welligent will create
County-specific enhancements or non-minor Welligent updates as configurable options, enabling
the County to control testing and deployment to its end users.

The Contractor shall use commercially reasonable efforts to complete system updates in LIVE
during scheduled downtimes windows; deviation from this shall be communicated as defined
under section 2., System Maintenance.

Prior to applying any County-specific enhancements or updates to the LIVE environment, The
Contractor shall make a full backup of the County’s production environment. The Contractor
must immediately notify the County once the update has been applied. The County will have up
to four (4) hours to complete production testing/validation following the application of the
update. Should any P1 or P2 level issues be reported within the four {4) hour window, the
Contractor shall offer the County the eption to roll back the County-specific enhancements or
updates to the version and data as of the time of the pre-update backup. The Contractor shall
offer other solutions, such as a patch or workaround, to resolve the issue.

Defects introduced by the system updates shall be considered Priority Level 1 obligations as per
below).

d. Response Time

The internal processing time for the Contractor to receive and process an Authorized User
transaction will be no more than two seconds not less than ninety-five percent {95%) of the time.
The more granular measures that impact this metric are:

1. Server Internal Processing Response Time: The length of time upon receipt of the
transaction at the Web Server request level. It shall not include network latency or client
lag time.

2. Round-Trip Transaction Response Time: The time taken for the application to complete a
transaction or business process. It shall not include network latency or client lag time.

3. 999 Milliseconds or Less Latency: The average monthly latency for server internal
processing response time is 999 milliseconds (ms) or less.

This response time pertains to the processing by the Contractor’s System and Software Service of
typical Authorized User transactions which may include search and retrieval, screen requests,
data edits and submissions (e.g., the time required for a round-trip between receipt of the data
by the Contractor’s firewall, processing by the Contractor’s System and Software Service, and
receipt back by the Contractor’s firewall}. Response time can be measured by creating a
timestamp when an Authorized User transaction (e.g., page request or submission) is received at
the Contractor firewall and measuring the difference between the time the transaction is
returned to the Contractor’s firewall. This measurement of transaction processing time includes
both database processing time and the transmission time on the Contractor’s internal network,
This response time may exclude some bulk processing requests including the generation of billing
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cycles, complex reporting and other similar Authorized User requests; provided, however that
such bulk processing requests have a response time that does not exceed thirty (30) minutes,
unless otherwise agreed to by the parties in writing. The elapsed time for actual end-user
response times will vary based upon factors outside of the Contractor’'s control, such as the
configuration and operaticn of the County’s Equipment (minimums as defined in Attachment 1),
bandwidth available to Authorized User, transmission delays caused by the County's Internet
service providers, and Internet latency outside of the Contractor’s or its Internet service
provider’s control.

e, Exceptions

The Contractor will not be responsible for failures to meet the provisions of Sections 1, 2, and 3
above (collectively, the “Service Level Requirements”} that are due to the following events: (i) any
latency or downtime due to acts or omissions by the County’s Authorized Users, (ii) acts of
unauthorized third parties; {iii) Internet latency, failures or outages outside of the Contractor’'s or
its Internet service provider's control; (iv) third party acts or omissions over which the Contractor
has no control; and (v) problems associated with the computer hardware and software systems
used by the County or its Authorized Users.

f. Obligation to Correct Defects, Priority Levels and Response Time

The Contractor will correct Defects in the Contractor’s System at no additional charge to the
County for as long as the County Continuously Subscribes and is in compliance with the terms of
this Agreement. The Contractor will respond to and use commercially reasonable efforts to
complete correction of Defects and failures of the Contractor’s System or Software Service to
perform in accordance with the Service Level Requirements in accordance with the following
schedule:

1. Priority Level 1: “Service Outage or Patient Safety” meaning the Contractor’s System is
not reasonably accessible or a defect of the software could pose a risk to the health and
safety the County’s clients. Upon receipt of a communication from the County indicating
that a Priority Level 1 Defect has occurred, the Contractor will make an initial response
acknowledging receipt of the County’s Priority Level 1 Defect within one (1) hour.
Priority Level 1 calls will be handled on a 24 hour, 7 days a week basis. The Contract or
will use reasonable best efforts to provide a work-around, or correct a Priority 1 Defect
within three (3) Regular Hours after acknowledging receipt of the Service Outage by the
Contractor.

i. Denial of Service (DoS) Response: The Contractor shall respond to the County’s
request for assistance in DoS attacks immediately upon notification.

ii. Reason for Outage (RFO) Response: To the extent that the root cause data is
available to the Contractor, the Contractor shall provide a report within S days of
the Contractor’s receipt of RFO for service interruptions at the Contractor’s -
owned data center facilities or the Contractor's service points.

2. Priority Level 2: A Software Service function does not work in accordance with the
Service Level Requirements, the Contractor’s Implementation Requirements, or
Documentation and Specifications, no reasonable work-around exists, and the County
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has a critical need far the function. Upon receipt of a communication from the County
indicating that a Priority Level 2 Defect has occurred, the Contractor will make an initial
response acknowledging its receipt of the County’s communication of a Priority Level 2
Defect within four (4) business hours. Priarity Level 2 calls will be handled during normal
business hours. The Contractor shall provide a fix or work around for Priority Level 2
Defects within three (3) business days after receipt of the report.

3. Priority Level 3: A Software Service function does not work in accordance with the
Service Level Requirements, the Contractor Implementation Requirements, or
Documentation and Specifications, but a reasonable work-around exists or the County is
able to wait for the next Release for a fix. Upon receipt of a communication from the
County indicating that a Priority Level 3 Defect has occurred, the Contractor will make an
initial response acknowledging its receipt of the County’s communicaticn of a Priority
Level 3 Defect reported within twenty-four (24) hours. Priority Level 3 calls will be
handled during normal business hours. The Contractor will use commercially reasonable
efforts to identify a resolution to Priority Level 3 Defects within thirty (30} days after
receipt of the report and incorporate Priority Level 3 fixes in the next Release of the
product.

g. Patches and Work-Arounds

Between regular Releases, the Contractor may, at its discretion: (i) provide a "patch" or software
fix developed to quickly resolve a Defect or critical regulatory requirement, with the
understanding that the patch has not been through a comprehensive quality assurance testing
cycle and may itself contain Defects; or (ii) suggest a “workaround”, or change in the procedures
followed or method of entry of data to avoid a Defect without materially impairing the County's
use of the Contractor’s System or Software Service.

h. Local database copy

The Contractor shall provide the County with secure ODBC access to all County Data stored in the
Contractor’'s database. On an as needed or ‘on-demand’ basis, the County shall have access and
be able to extract County Data for use in its own database systems.

i. State and Payer Requirements

The Contractor shall, at no cost to the County, implement fixes and enhancements to ensure
timely compliance with requirements imposed by federal agencies, State of Virginia and the
County's in-network insurance companies. This includes requirements that are in place at the
time of this agreement as well as new requirements imposed over time. For clarity, this is part of
the Software Services. This includes but is not limited to:

1. Mandated forms identified in the Scope of Work (Attachment A): Forms List

2. Virginia Department of Behavioral Health & Developmental Services Performance
Contract and Community Consumer Submission 3 (CCS3) requirements for data capture
and timely reporting (examples may currently be found at
http://www.dbhds.virginia.gov/professionals-and-service-providers/office-of-support-
services )

3. Woaiver Management System (WaMS5) EOM data capture and timely reporting {outlined in
the Scope of Work (Attachment A) interfaces.
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j- Standard Assessment Forms

The Contractor shall, at no cost to the County, implement fixes and enhancements to
standardized assessment forms used by the County. For clarity, this is part of the Software
Services. Current standard assessments (“Standard Tools”) are outlined in the Scope of Work
{Attachment A, Forms List.

k. Information Security

The Contractor’s Security System shall be consistent in all material respects with the best
practices for such systems within its industry. In addition, the Welligent System will comply with
the standards and implementation specifications of the HIPAA Security Rule (45 CFR Paris 160 —
164, Subpart C).

l. Redundant Data Centers and Infrastructure

The Contractor shall ensure that all County Data that is hosted by the Contractor shall be
maintained on secure servers located in at least two data centers owned, operated and
controlled by the Contractor and physically located within the United States (each, a “Data
Center”). The primary Data Center in which the primary server resides is currently located at
PhoenixNAP, 3402 East University Drive, Phoenix, AZ 85034 {“Primary Data Center”). As part of
the hosting services provided hereunder ("Hosting Services”), the Contractor shall ensure that
redundant copies of the County Data shall simultaneously reside in a backup server physicaily
located in another Data Center which is currently located at PhoenixNAP, 34 Peachtree Street,
Atlanta, GA 30303 (“Back-Up Data Center”). (Primary Data Center and Back-Up Data Center
collectively, “Data Centers”). At its discretion, the Contractor may upgrade or relocate its Data
Centers to equivalent facilities located within one of the fifty (50) states or the United States or
any of the United States territories, in order to best meet the County’'s needs. The Contractor
shall ensure that the County’s Data is encrypted in transit and at rest (including at the Back-Up
Data Center).

m. Data Backup

The Contractor acknowledges and agrees that all County Data, including system logs, is stored
and maintained in the Contractor’s System such that all data is accessible in the then-current
version and backup of the Contractor’s System. The Contractor will incrementally backup
Customer Data stored on the Contractor’s System on a daily basis. Each week, the Contractor will
perform a full backup of the County’s Data. Weekly full backup copies will be stored for two (2)
months. Each month, the Contractor will perform a full backup of the County’s Data and store
the backup copy at an offsite location. Monthly full backup copies will be stored for six (6)
months. The County will maintain the right to access data stored on the Contractor’s backup
system for any reason during the six-month period when backup media is maintained. The
Contractor shall restore data identified for restoration request into the Contractor’s environment
chosen by the County.

n. Disaster Recovery
The Contractor shall implement and maintain a commercially reasonable disaster recovery plan
(“Disaster Recovery Plan”), consistent with the highest industry standards in healthcare, to enable
the Contractor to resume operation of the Software Service and the Contractor's System, install
the most recent backup copy of the County’s Data which will be no older than one hour
("Recovery Point Objective”), and enable the County to resume operations within 24 hours
(“Recovery Time Objective”). The Contractor shall test the effectiveness of its Disaster Recovery
Plan periodically, but neo less than annually. The Contractor shall update or modify its Disaster
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Recovery Plan, provided it is, at all times, commercially reasonable. Upon the County’s written
request (no more than once each year), the Contractor shall provide the County with a copy of
the Contractor’s then current Disaster Recovery Plan.

0. Secure Data Transmission

Communications between County Authorized Users and the Contractor’s System that include
access to or transfer of County Data will be over a secure connection utilizing encryption and
shall comply, at a minimum, with all applicable HIPAA rules, regulations and requirements.

p. Contractor Staff

All of the Contractor’s employees performing services to the County will receive training about
compliance with applicable security standards and protection of the privacy of County’s Data. The
Contractor warrants and covenants that it shall require all of its employees, contractors, agents
and other authorized individuals whao have access to its Data Centers to adhere to its written
security policies and procedures regarding remote electronic access or physical access to a Data
Center which shall be provided to the County upon execution of this Agreement and as requested
thereafter. The Contractor shall enforce such security policies and procedures and shall take
appropriate corrective action against any individuals who fail to adhere to such security policies
and procedures, including termination.

g. Contractors and Third Parties

The Contractors, contractors, sub-contractors and third parties with access to County Data,
Contractor’s System or the Software Service will sign the Contractor’s Business Associate
Agreement. Additionally, contractors and third parties with access to County Data and PHI will
receive training about compliance with applicable security standards and protection of the
privacy of the County’s Data.

r. Off-shore Resources
The Contractor shall not directly or indirectly transmit or transfer to, or allow access from any
Offshore Location to any County Data (including PHI) without the County’s prior written consent,
which consent may be withheld for any or no reason. Any such consent, if given, may be
conditioned upon, among other things, the County’s satisfactory and timely completion of an
Attestation Concerning Offshore Contractors and any other such requirements from Centers for
Medicaid & Medicare Services. For purposes of this section, the term “Offshore Location” shall
mean any location not within one of the fifty (50) states of the United States or any of the United
States territories.

5. Notification of Security Incidents

The Contractor shall notify the County immediately, but no later than twenty-four {24) hours
after discovery of any security incident that resulted in or that may have resulted in unauthorized
access, use, disclosure, modification, or destruction of the County’s Data. In addition, the
Contractor shall comply with all applicable notification requirements of the Business Associate
Agreement (Attachment C) and HIPAA,

t. Audits

At least once each year during the Term of the Agreement, the Contractor will engage an

independent third party to conduct an annual audit of the security of the Contractor’s

information systems, Welligent System, and the Software Service, including the security

management program and system security at the Contractor’s data centers, in accordance with
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the Contractor’s security measures (the “Security Audit”). Standards reviewed in the audit are to
include, but no be limited to SSAE 16 Type |l requirements. Upon written request, the Contractor
shall provide the County with a copy of the current Security Audit. The Contractor will promptly
correct any deficiencies and implement any process improvements recommended as a result of
such Security Audit. The Contractor shall ensure that any third party with access to the
Contractor’s information systems, Welligent System, and the Software Service will sign the
Contractor’'s Business Associate Agreement.

u. Compliance with Privacy and Data Security Laws

The Contractor shall comply with applicable federal and state laws and regulations governing the
confidentiality and security of the County’s Data, including but not limited to, HIPAA, FERPA, and
42 CFR Part 2 (confidentiality of alcohol and drug abuse patient records). The Contractor will
enter standard form agreements with the County, as acceptable to the Contractor, as necessary
to comply with applicable lega! requirements, such as a HiPAA Business Associate Agreement or a
Qualified Services Organization Agreement.
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ATTACHMENT |

MINIMUM TECHNICAL ENVIRONMENT

Personal Computer Minimum Specifications

e Operating System: Mac 05 X, Windows 7 with Service Pack 1, Windows 8 with Service Pack 2 or
Windows 10 with Internet Explorer 11. (https://technet.microsoft.com/en-
us/library/mt156988{v=vs.85}.aspx) (Note: Microsoft no longer supports Windows versions: 2000

and XP).

s  Memory: 4 GB RAM is recommended.
e Processor: A P4 processer or greater and at least 50 MB of free space on each hard drive.
s Monitor: A monitor supporting a resolution of 1024x768 or higher, with suitable video for
displaying web browser application screens.
e Note: For hand held devices, Welligent functions best on desktops and laptops. Due to the
modified browser versions on hand held devices, the Welligent Application currently does not
fully support these devices. Apple iPad functionality will be launched in the Spring of 2016.

Android and iOS Device Specifications

Android Device 105 (Apple) Device
Spec IS e e iPad 2+, iPaFI Air 2+, iPad Mini2+,
iPhone 5+
Operating System (0S) Android 5.0+ 10S 8.0+
Processor Dual Core+ Dual Core+
Ram 1GB+ 1 GB+
HDD 16 GB+ with at least 500 MB free space | 16 GB+ with at least 500 MB free space
Screen Size 10+ inch best for viewing; 7-8 inch will 10+ inch best for viewing; iPhones and
work iPad minis will work
Network WIF| or 4G WIFI or 4G
Camera 2 MB+ 2 MB+

Web Browser Minimum Specifications

s Web Browsers for PC users: Microsoft Internet Explorer - Version 11 or Google Chrome —
Versions 38 or newer. *Mozilla Firefox and Edge are not currently supported. (Note: Microsoft
recently no longer supports Internet Explorer 9 and 10 {www.microsoft.com/en-
us/WindowsForBusiness/End-of-IE-support).

e Web Browser for Mac users: Safari - Version 2.0.4 or higher. *Internet Explorer and Mozilla
Firefox are not supported.

e  Minimum Advanced settings for Transport Layer Security (TLS) are 1.1, but 1.2 is ideal.

Required Third Party Software and Browser Plug-ins {Internet Explorer QOnly)
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e Adobe Reader: Required for all end-users — Version 9.0 or higher. No other PDF reader
applications, such as Foxit and Google Chrome, are acceptable especially when using PDF eForms.

e Adobe Professional: Required only for users creating PDF forms in Welligent — Version 8.0 or
higher.

» Mead Script ActiveX (7.1.0.60). Plug-in used by the Contractor to enhance report formatting.
Please install to ensure proper printing of documents when a popup appears asking for
permission. Many Contractor reports are designed to print in Landscape; the user must have
Mead ActiveX installed for the Landscape version to print correctly,

Optional Third Party Software and Browser Plug-ins {Internet Explorer Only)

e Topaz SigPlus Pro ActiveX {v4.4.0.6). Plug-in to capture digital signatures using signature pads
from Topaz Systems, Inc. Welligent has certified the following digital signature capture pads:

o Siglite Interactive LCD Series Model T-L460-HSB-R (non-backlit)

o Sigtite Interactive LCD Series Model T-LBK460-HSB-R {backlit)

o Other signature capture products from Topaz may work with Welligent. Please visit the
Topaz Systems, Inc. website at www.topazsystems.com for more information.

o Welligent’s digital signature capture functionality does not currently support products
from other vendors.

o Currently, Topaz signature pads are not compatible with Safari or Google Chrome. A Sign
by Mouse Method Welligent Option is available for these browsers, Please contact
support@welligent.com for information,

o Toinstall the SigPlus software visit: http://www.sigpluspro.com/Software/sigplus.exe

e Secure File Transfer Software. Available for agencies that need to upload or download large files
or files requiring secure transfer. A software recommendation will be made based on file size.

Internet Connectivity and Bandwidth Minimum Specifications

e At least 64 Kbs internet bandwidth per dedicated user is recommended. This type of Internet
connection or higher can be obtained through ISDN, DSL, Cable Modem, T1 and T3 lines.

e The Contractor recommends using dedicated Internet connections as they provide a more
consistent Internet connection. Wireless networks are acceptable, but there may be external
issues with wireless networks that cannot be controlled (e.g., transmission interference), and the
actual speeds often runs less than their capacity.

* Note that an organization’s specific bandwidth requirements may vary depending on the number
of dedicated users, uploading or downloading large custom files on the organization’s network
to/from the Welligent system, or by incorporating large, custom PDF forms into the Welligent
system.

* Welligent software can be used over wireless networks including Wi-Fi or cellular networks.
Ensure the organization has implemented adequate security protocols (e.g., Wi-Fi Protected
Access || (WPA2).

e The Contractor strongly recommends against using Welligent on public, unsecured wireless
networks (e.g., free Wi-Fi at airports, Starbucks, etc.) Be aware that user names and passwords
can easily be compromised in such environments.
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Recommended Firewall Settings

The Contractor recommends that the following configuration changes be made to the County’'s DHS
firewall settings for each agency location. These adjustments guarantee a minimum of interference from
the firewall and ensure that the Contractor’s traffic is given priority without exposing your agency to

cyber-attacks.

e Firewalls should be tuned to give priority to https (port 443 — S5L) connections and to recognize
the Welligent domain as a trusted site {(welligent.com).

o Allow firewall access to:

o http://www.welligent.com {Open port 80)

o https:/fapps.welligent.com (Open port 443}

s Within the firewall, all restrictions should be removed between internal computers and
Welligent's production server: apps.welligent.com

e Quality of Service {QoS) should be turned on for HTTPS/SSL traffic from internal computers to
Welligent’s site giving priority within the network to users accessing Welligent. This will help
ensure that Welligent users don’t have to compete against users accessing publicly accessible

websites.

e RPF-Check should be turned off for each policy class command. Welligent's traffic pattern
behaves in a manner which certain firewalls may view as a potential intrusion. By turning RPF
check off for the Welligent IP address, the Welligent system will run more effectively with fewer

denied windows,

e The FIN timeout command should be set to a high number. This will ensure that the firewall
keeps connections to Welligent open long encugh to retrieve long-running reports or forms,

The following instructions may vary based on operating system type and browser version.

Required Configuration Settings

automated pop-up
blocker that may affect
screens in Welligent,

If you select a button
or function in
Welligent, and see a
flash of the screen
where no change
occurs, this could
indicate the pop-up
blocker feature is on.

1. Open Internet Explorer>Menu
Bar>Tools>Pop-up Blocker>Pop-up Blocker
Settings

2. Add Welligent to the Allowed Sites>
Enter: apps.welligent.com in the Address of
website to allow field>Add>Close.

Also, if a bar across the top that indicates a
pop-up is being blocked:

1. Click on the bar and select: Always allow
pop-ups from this site.

2. If you get a pop-up asking if you want to
navigate away from the website, select:
Cancel or the X in the upper right corner of
the pop-up.

Setting Comments Steps Notes
1. Pop-Up By default, Windows Before logging into the Welligent If the Pop-up Blocker
Blockers may contain an Application: Settings option is grayed

out, then you are not
blocking pop-ups.

To temporarily allow a
pop-up or determine a
pop-up is blocked, hold
down the CTRL key while
clicking on the link.

To test the pop-up
setting in Welligent,
select a Welligent date
picker icon to ensure the
POpP-up screen appears.

2. Contractor

Copy
Function/ActiveX

ActiveX and Scripted
Window settings are
necessary for the Copy

1. Open Internet Explorer>Menu
Bar>Tools>Internet Options>Security Tab>
Internet Icon>Custom Level Button,

The Enable setting is
recommended to reduce
the amount of future
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| and Scripted
Window Settings

function to work in the
Welligent Application.

2. Scroll down to ActiveX controls and plug-
ins section. Enable/Prompt the following:
Allow Active X Filtering; Allow previously
unused ActiveX controls to run without
prompt; Allow Scriptlets; Automatic
prompting for ActiveX controls; Binary and
script behaviors; Display video and
animation on a webpage that does not use
external media player; Download signed
ActiveX controls; Download unsigned
ActiveX controls; Initialize and script ActiveX
controls not marked as safe for scripting;
Only allow approved domains to use ActiveX
without prompt; Run ActiveX controls and
plug-ins; Script ActiveX controls marked safe
for scripting®.

3. Scroli down to Scripting section.
Enable/Prompt ali settings.

Also, if a message box appears: Temporarily
Allow Scripted Windows from This Site or
Always Allow Scripted Windows from this
Site>Select: Always>0K>Apply.

request pop-ups from
ocecurring.

3. Adding
Welligent as a
Trusted Site

Welligent users need to
enter Welligent as a
Trusted Site.

1. Open Internet Explorer>Menu
Bar>Tools>Internet Options>Security
Tab>Trusted Sites lcan>Sites button.

2. Enter: https://apps.welligent.com

3. Check: Require server verification {https:
for all sites in this zone)>Close.

This setting affects the
functionality of many
screens in Welligent and
is necessary for the use
of Topaz signature pads.

4, Check for
Newer Versions
of Stored Pages

Internet Explorer stores
copies of previously
visited web pages.
Welligent's
functionality looks for a
new page every time.

1. Open Internet Explorer>Menu
Bar>Tools>Internet Options>General
Tab>Settings Button in Browsing History.

2. Under: Check for newer versions of stored
pages, select: Every time | visit the
Webpage>0OK.

This setting affects many
functions in Welligent
and is necessary for
Welligent eForms to save
information properly.

5. Printing from
Welligent

Print Preview Setup:

1. Remove the Web Page Information (URL)
from the Header & Footer

A. Open Internet Explorer>File>Page Setup
and delete the typing in the Header and
Footer fields.

B. In each Margin field {Left, Right, Top, and
Bottom) enter a zero>0K. The computer will
automatically reset the margins to be as
close to zero as possible.

2. If a printed page is larger than the screen
display: Open Internet Explorer>Menu
Bar>View>Text Size>Select a smaller text
size than currently being used.

3. If Welligent radio buttons are not printing,

Step 1 is necessary to
print the HCFA/CMS 1500
and UB-04.
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the Microsoft Windows theme needs to be
changed to Windows Classic: Microsoft Start
Icon>Control Panel> Appearances and
Personalization>Change the Theme>
Windows Classic and Color
Scheme>Windows Standard>Apply>Close.
4. If a Welligent report is wider than 8.5
inches and the orientation is set to
Landscape (which can be identified by a
scroll bar at the bottom of the Welligent
screen), please change the Print Properties
from Portrait to Landscape.

6. Creating
Adobe PDF
eForms in
Welligent

In order to use Adobe
PDF eForms, end users
must have Adobe
Reader 9+ installed and
users creating PDF
efForms must Use
Adobe Acrobat 8+.

Potential Adobe message: The file you have
opened complies with the PDF/A standard
and has been opened read only to prevent
modification: Go to the Adobe Reader
Menu>Edit>Preferences>Documents>PDF/A
View Mode>Never.

Tips for PDF eForm Qverwrite settings:

1. Do not overwrite form value - will use the
database value if there is no value in the
form.

2. Always overwrite form values with
database values - overwrites the field if a
database value exists.

3. Overwrite only on unlocked forms - will
use the non-null database value if there is
no value in the form. If the database is nuil it
will not get rid of the value that is in the
form. It will only do this if the form is not
signed {locked).

4. Only overwrite form values with non-nuli
database values - will use the database value
if the database value is not null.

No other PDF reader
applications {Foxit,
Google Chrome, etc.) are
supported and some
combinations of Adobe
and Safari prevent PDF
eForms from populating
/saving correctly.

7. Adobe PDF
eForms and
Internet Explorer

Using Adobe PDF
eForms with Internet
Explorer requires a
setting update.

To ensure Internet Explorer and PDF eForms
compatibility, please: Open Internet
Explorer> Menu Bar>Tools>Manage Add-
ons>Show Filter: All Add-ons>Adobe PDF
Reader>Select Enable>Close.

Welligent recommends
Internet Explorer 11
when using eForms.
Adobe PDFs are no
longer compatible with
Google Chrome.
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Optional Configuration Settings

Setting

Comments

Steps

Notes

1. Best Viewing

Monitor Resolution /
Display settings are
important to reduce
the use of scroll bars at
the bottom and to have
optimal display of the
Welligent Application.

1. Depending on monitor size, resolution
should be set at 1280x1024 for larger
monitors or 1024x768 for smaller monitors
for best display. (Microsoft Start
icon>Control Panel>Appearances and
Personalization>Display>Change Display
Settings>Change to 1280x1024 or
1024x768 >Apply) or (Apple> System
Preferences>Displays>Select 1024x768).

2. Open Internet Explorer>Menu
Bar>View>Text Size. The size should be set
at Medium or less.

3. Maximize the computer screen for best
viewing: Click on the single square in upper
right hand corner. For Mac users: At the
bottom right hand corner of the window
and drag the window larger.

4. Close unused tool bars at the top of the
browser window. Internet Explorer>Menu
Bar>View>Toolbars>Uncheck any unused
toolbars,

2. Placing the
Welligent Icon on
the Desktop

For easy access to the
Welligent Application

1. Go to www.welligent.com and select the
Production link.

2. Do not enter your login information.
3. Select: File (upper left)>Send To
Desktop>Check the Desktop for the icon.
4. Rename the Welligent icon on the
desktop, if desired. Select the Welligent
icon>Right click on the icon>Select:
Rename>Type in a new name>Click in an
open space on the desktop to lock in the
name change.

5. To open Welligent, double click on the
Welligent icon.

3. Temporary
Internet
Files/Cleaning the
Cache

To maintain
performance, we
recommend deleting
Temporary internet
files regularly.

For Internet Explorer, go to the Menu
Bar>Tools>Internet Options>Browsing
History>Delete Button>Ensure Tempaorary
Internet Files is checked>Delete.

For Safari, go to the Menu
Bar>Safari>Empty Cache.
For Google Chrome, go to
the Control button>
Settings>History>Clear
browsing data.

4, Computer Shut
Down

We recommend
occasionally shutting
down computers
accessing Welligent.

This will help refresh browser connections
and restore any loss of memory.
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Welligent Application Options

1,

Screen Security - To protect private information, use the Hide My Screen function in the
Welligent Application. The screen will remain locked until the user enters their Welligent
password. Also, selecting the Micro Soft Logo + L will also lock a computer from access. Note as
a default, Welligent will time out after 15 minutes from the lack of use prompting a user to
reenter a password.

Refreshing the Welligent Application - When a configuration change has been made to the
database, the system needs {o be refreshed to update the display of the new information. For
Microsoft — Right click>Refresh next to the upper left of the Welligent Application screen.

For Mac - Use the CMD+R shortcut or click the reload the current page icon on the right side of
the address bar. In the event a user receives a message that access is forbidden, please “Quit
Safari” (Menu Bar>Safari>Quit Safari) and reopen the browser.

System Errors — Qccasionally, users may get a pop-up message citing a system error and a
diagnosis number. Use Welligent Report #1556 Error Code Analysis to determine meaning of
error. Please report these messages to Welligent via Support Central. Please provide us with the
diagnosis number, the error message, and a path to the screen where the error occurred.

Saving — A user must select the Welligent Save button to capture data entered into Welligent. By
default, a pop-up will appear informing a user that the information was successfully saved to the
database.

Client Search Fields = When searching for a client, a user can type a few letters of the last name
and the first letter of the first name to narrow the search. Using this recommendation may
reduce duplication of records by catching previous errors and potential misspellings.

Keyboard Tips — When entering data it may be easier to use the Tab key to move from field to
field. Also, instead of using a mouse to select the Welligent Search button, hit the Enter key.

Using the Drop-Down Fields - Many Welligent fields are completed by selecting an option from a
drop-down list of choices. A user may speed up the selection by tabbing to the field and typing
the first letter of the option desired. Once the choice displays, a user can tab to the next field.

Copy and Paste — A user can copy and paste text from other documents into Welligent. Important
Note: In order to prevent problems with spacing and text format within Welligent, caused by
invisible characters or formatting from documents in Microsoft Word, for example, we
recommended cutting and pasting into Notepad to remove hidden codes.

Passwords - To change a Welligent password, select My Preferences in the Welligent
Application>0Other>Change Password. Please do not share Welligent passwords with others or
select for a computer to save passwords for future use. Passwords must be 5-10 characters in
length. They cannot include a space, symbols, and must not start or end in a zero.

If you have any questions concerning this document, please contact Welligent Support at:

support@welligent.com or submit a Support Central ticket.
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ATTACHMENT ]
SCOPE CHANGE PROCEDURE

The County may request a change in the scope included in this SOW at any point in the execution of the work
hereunder. Agreed upon Requests for Change (RFC's) shall amend the applicable SOW by a fully executed
amendment to this Contract and shall be incorporated herein by reference. Contractor shall not be liable for
any Professional Services or Deliverables that are not set out in this SOW or an approved RFC. Changes may
impact cost and delivery timeframe.

Project Cost Summary

The delivery of the enhanced County Welligent System is based on the specific activities outlined in this
Agreement. Throughout the life-cycle of this project additional activities and changes in deliverables may
be requested. Estimates will be provided that detail the requirement and/or activity as attachments to
this SOW as a Request for Change (“RFC") or Request for Service (“RFS”). The attachments to the RFC's
and RFS’s will have costs and detail the requirement and/or activity to be performed. All RFC's and RFS’s
will need to be approved and accepted by both Contractor and County prior to their commencement to
be a valid cost to County.

Reguest format
Requester:
Requestor Name and Title:

Requestor Phone Number:

Requestor Email:

Scope Change Summary:
Request Date:

Estimated Completion Date:
Cost:

Hours:

Impact To Go-Live:

Priority:

Short Description:

Scope Change Details:
Module:

Reason For Change:

Design Info:
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ATTACHMENT K

SOURCE CODE ESCROW

AGREEMENT

SOFTWARE
ESCROW
PROGRAM

Welligent Inc

Powered by NCC Group, Inc.

wekgen! Inc. has parnered wilh NCC Group, Inc. to provide the opportunily to join
their Saltware Escrow program. Weligenl assembled the proper agreement (Multi-
licensee Deposit Account Agmeoment), release conditions, and Escrow deposit
malenak 1o provide the foundalion lor your company to receive Ihe proper Softwore
Escrow prolection lor your invesiment in Welligeni world class technology. Weligeni
proachvely established this parinenhip based vpon NCC Group's best proclice
Soitware Escrow solutions. In order o mare fully reclize Welligent clienl satisfaction,
Weolkgent extends an offer lor your organiration 1o register into this program,

A Software Escrow ggreement s g specialized form ol assurance, whereby an
independan! third-party Software Escrow Agent {in this case, NCC Group) enters into
on ggreemant with the lechnology Developer (Weligent) and ther Licensee [your
organizatfion} to cover business-critical applications. This service allows the Licensee
to gain access lo the softwaore source code and/or other intelactual property in the
evanl that Weligen! is no longer able lo fulfll ils conlractuol obligations. A Software
Escrow salulion not only provides access o the source code but okoe granls the
Licensee the legal righl 1o use the code in accordance with the terms sael lorh in the
License Agreement. By establishing a Software Escrow agreement, welligenl nal only
demanstrates That they are commitled 1o buiding lang-lerm ralationships with their
chents, but ako that Weligent has confidence in their luture.

weligen! engages in o bes! praclice; hay set up the program al ther own cost. and
they deposit updated sourca code with NCC Group on a consistent basis. o parlicipale
dnd become o benobciary of the 3oftwore Escrow Agreeman, the Licerses [your
organization} must relurn a completed and signed Regitration Agreement to NCC
Group, who will send g wiitlen notice lo both Waeligent and the Licensee once the
Registralion Agreemenl has been fuly execulad.

All ihe escrow daposils NCC Group receives ane Integrity Tested lo ensure they contain
occcassible souwrce code of other forms of proprietary technology  The source coda is
held inane af NCC Group's secure media vaulls which are monilored 24 hours a day,
seven days o week. Further, NCC Group aclively pursues updated depaosits of code
on al lecst an cnnual basis 1o ensura that they possess the latest version of code. NCC
Group ako providas an onine portol, Escrow Live, so ol regilered parlies can view
Ihe stalus of thew Software Escrow accounls, maintain crucial client dalo, and confirm
that ther Software Escrow program is in compliance with thek poficies. Al ckents may
addilionally elect to have NCC Group conduct o Full verification of the deposils. This
is a process whate the source code is rebuil info the object code {executable) version
of the solhware opplicalion to enswe all relavant componants, scripls, and source
coda are prasent. The entio builkd process is udited and recorded within the msulting
A Verification report which woukd be used by your company to builkd and maintain
the application, shoutd it ever become necessary lor the source code to be relecsed
under the terms of the Softwara Escrow Agreement.

wefigent and ils poriners will beneht kom having g dedicated Clienl Services Execulive
at NCC Group who wil work wilh ol sides lo enswe thal your Soltware Escrow porticko
i olways up-to-dale as wel as provide odvice ond guidance as lo which Softwore
Escrow ogreement or level of 1esting will best suit your given situation,

nccgroup

assurg -secure -advise

Why NCC Group?

World's largest software
esciow provider

Publicly Traded Company
with annual revenues
exceeding 570M

30+ years of experience
Software source code
verification experts

Clients include 92 of
the Forfune 100

Contact Details:

Andy McCraw, President
Welligen! inc

Phone. (757) 231-5980

Email: ame crawdweligent com

Andrew Moore

Clien! $ervices Execulive. NCC Gioup
Phone: {415) 457-2231

Email: andrew. mooredncegroup.com

NCC Group, Inc.
1731 Technology Drive. Suile B30,
San Jose, CA 9%1 10

NCC Group, Inc. 1731 Technology Drive, Suite 880, San Jose, CA 95110

Phone: (408} 441-4440 Emal: usodnccgroup.com web: www.nccgroup.us Yanion |_Febrary 2011
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ATTACHMENT T

Arlington County CSB Program Descriptions

Aging and Disability Services Division
Children’s intellectual-Developmental Disabilities Services
e Services for children with intellectua! and/or developmental disabilities and their families.

o  Links families who have children with intellectual and/or developmental disabilities to
rehabilitation and vocational services that promote and support independence and self-
sufficiency in the home or community.

e  Provides transition planning and services to adulthood in cooperation with the schools.

Developmental Disability Services

*  Assists adults with developmental disabilities and their families with finding and using
community services.

e Services include helping individuals participate and live safely in the community; helping
individuals find suitable living situations; helping individuals find suitable work or day placements.

RAFT: Regional Older Adult Facilities Mental Health Teamns
o A multidisciplinary treatment team (therapists, psychiatrist, psychologist, and nurse practitioner)
that provides intensive mental health services to older adults (65+) in long-term care facilities in
Northern Virginia.

o  Diverts seniors from being admitted to state hospitals by placing them in a Northern Virginia
nursing home or assisted-living facility.

e Senior Adult Mental Health

e Provides mental health services to individuals age 60 and older who are living with mental illness
or emotional disturbance.

e  Services include individual, group, and family counseling; psychotropic medication monitoring;
multidisciplinary evaluation; case coardination.

e Home visits are available for individuals who are unable to leave their homes.
Specialized Mental Health Services for Adults with Intellectual and Developmental Disabilities

¢ Provides mental health services for residents age 18 and older with intellectual and
developmental disabilities and mental health needs.

o C(Clients are assigned a therapist who helps with services including assessment, psychiatric
evaluation, psychotropic medication monitoring, and psychotherapy.

Behavioral Healthcare Division

Abuser Intervention Program
e Offers educational group services to help people who have been physically or emotionally
abusive within their family relationships to have an increased understanding of domestic
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violence and its impact on the family; learn appropriate and effective ways to handle anger; and
understand the importance of taking responsibility for behaviors.

* Requires a commitment of at least 36 hours over an 18-week period for successful completion.

Adult Mental Health/Community Support Teams
e (Comprehensive, cammunity-based mental health services for adults with mental iliness to help
them achieve the maximum level of functioning, minimize symptoms, reduce frequency of
hospitalizations and enhance their recovery.

e Services include case management, crisis intervention, psychotherapy and psychoeducation, and
residential support services.

o Staff also support those with co-occurring mental health and substance abuse disorders, and
young adults transitioning to the adult mental health system.

Clarendon House
e A community-based rehabilitation program for adults with serious mental illness that promotes
the highest level of community integration in housing and employment and aims to prevent
psychiatric hospitalizations.

® Services include vocational, social, independent living and illness self-management training and
family support; case management; and psychiatric services.

Crisis Intervention Training
e Provides crisis intervention training for law enforcement to safely and efficiently divert adults
with serious mental iliness from jail.

e  CIT curriculum provides law enforcement professionals with 40 hours of training in crisis de-
escalation technigues and active listening skills.

Discharge Planning
e Connects adults discharged from the state psychiatric hospital to community mental health
services and stable housing, and prevents their rapid readmission to the state hospital.

e Services include assessment of client needs and placement in appropriate clinical and residential
services upon discharge. Services begin upon admission to the hospital.

Emergency Services
e Provides round-the-clock, immediate assistance to individuals experiencing a mental-health crisis.
The goal is to prevent the crisis from warsening, relieve immediate distress and prevent
individuals from harming themselves and/or others.

¢ Services include crisis intervention, assessment, referral, consultation, and pre-admission
screening for individuals who may require voluntary or involuntary hospitalization.

Forensic Case Management

¢ |ntensive case management and assessment services for individuals with serious mental illness
experiencing difficulties in the criminal justice system.

# Services include case management and linkages to health services, medical and other critical
needs.
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Homeless Case Management
s Serves homeless aduits with serious mental illness and/or substance abuse problems.

® Provides assessments, case management and linkages to appropriate services and housing
resources.

job Avenue
e Provides supportive employment services to adults with mental iliness based on individual choice.

e Services include work preparation training, on-the-job assessments, job development, job
placement and training.

Mental Health Jail-based Services

« Delivers mental health services to inmates of the Arlington County detention facility in
accordance with correctional policies and the procedures of the Sheriff's office.

e  Services focus on meeting treatment needs, teaching skills to manage symptoms, and linking
Arlington clients to outpatient services as needed.

Mental Health Residential Services

e Provides a continuum of residential and related supportive services for adults with serious mental
illness to promote successful community living.

e Clients are served in group homes, assisted-living facilities, residential crisis stabilization services,
intensive supported living services, transitional housing for persons who are homeless, and the
permanent supported independent housing program.

Program for Assertive Community Treatment {PACT)

* PACT provides community-based services to persons who need ongoing, comprehensive services
to enable them to successfully live in the community. The PACT Team partners with consumers to
help them optimize mental and physical health, develop competent life skills, strengthen
supportive relationships, and reach their vocational and income goals,

e PACT offers intensive treatment, rehabilitation and support services on an outreach basis in
participants’ homes, on the job or in other community settings

Projects in Assistance for Transition from Homelessness {PATH)
e Serves people with serious mental illness, including those with co-occurring substance-use
disorders, who are experiencing homelessness or are at risk of becoming homeless.

e Services include community-based outreach, mental health, substance abuse, case management
and other support services, as well as a limited set of housing services.

Screening and Intake
s Single point of entry for Behavioral Healthcare Division clients.
e Screens potential clients for services, schedules and completes intake assessments, connects
clients to ongoing services.
Substance Abuse Case Management and Residential Treatment Services
s Residential treatment and case management support for adults with substance abuse problems.
Individuals are evaluated by case management staff and placed in the appropriate level of
residential treatment.
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¢ Contract services include social and medical detoxification and residential treatment and
transitional living placements to facilitate recovery from substance abuse. Case managers
monitor clients at contracted agencies.

Substance Abuse Jail-based Services
e Assessment, early intervention, prevention, treatment and case management services to those
incarcerated to prevent further deterioration and involvement in criminal activities.

e Services include the ACT Program {prevents deterioration and prepares individuals for recovery
from alcohol and drug dependency} and the Mental Health Jail Treatment Unit {serves to
prevent suicide and facilitate psychiatric and behavioral stabilization).

» Both programs help place individuals in outpatient or residential aftercare settings after release.

Substance Abuse Qutpatient
e Services include assessment, individual and group therapy, alcohol and drug education courses,
relapse prevention services, psychological evaluations, drug screenings and access to
community-based support groups.

e Alimited number of adults using narcotics can receive methadone treatment through a contract
with the Alexandria Community Services Board.

Child and Family Services Division
Behavior Intervention Services
e Helps caregivers and teachers improve the behavior of children who consistently demonstrate
aggression or defiance.

e Services include hands-on instruction in behavior-change strategies; consultation with the family
and others about behavior; referrals to services.

Children’s Behavioral Healthcare Services

» Offers therapeutic services to children and teens with menta! health and substance abuse
problems, and their families.

e Services are provided in the office, and at family homes, schools, or other community sites, and
include screening sand diagnostic review, individual, family, and group therapy, case
management, and substance abuse prevention.

PIE: Parent-Infant Education
e Provides family-centered, educational and therapeutic services for children with developmental
delay and disability.

e The purpose of the services is ta improve child outcomes by reducing the impact of
developmental delays and disabilities in children from birth to third birthday.
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CERTIFICATE OF LIABILITY INSURANCE

DATE {MM/DD/YYYY)
127712017

THIS CERTIFICATE IS ISSUED AS A MATTER OF INFORMATION ONLY AND CONFERS NO RIGHTS UPON THE CERTIFICATE HOLDER. THIS
CERTIFICATE DOES NOT AFFIRMATIVELY OR NEGATIVELY AMEND, EXTEND OR ALTER THE COVERAGE AFFORDED BY THE POLICIES
BELOW. THIS CERTIFICATE OF INSURANCE DOES NOT CONSTITUTE A CONTRACT BETWEEN THE ISSUING INSURER(S), AUTHORIZED
REPRESENTATIVE OR PRODUCER, AND THE CERTIFICATE HOLDER.

IMPORTANT: If the certificate holder is an ADDITIONAL INSURED, the policy(ies) must be endorsed.

If SUBROGATION IS WAIVED, subject to

the terms and conditions of the policy, certain policies may require an endorsement. A statement on this certificate does not confer rights to the

certificate holder in lieu of such endorsement(s}.

PRODUCER

London & Norfolk, Lid.

999 Walerside Drive #2500
Norfolk VA 23510

'INSURED WELLIA
Welligent, Inc. and/or

Welligent Properties LLC

i ] Jacqueline Spurrier

T =2y

Fhoe u: 757-623-0003 ] | (A, Noy:
ADOHESS: JSpumer@LNorrolk com

INSURER(S) AFEORDING COVERAGE NAIC #
INSURER A : Travelers Prop CasualtyAmerica 25674
INSURER B : The Travelers Indemnity Co 25658

INSURER C : Travelers Casually Co of CT

5205 Colley Ave INSURER D :
Norfolk VA 23508 INSURERE :
INSURERF ;
COVERAGES CERTIFICATE NUMBER: 1567033377 REVISION NUMBER:

THIS 1S TO CERTIFY THAT THE POLICIES OF INSURANCE LISTED BELOW HAVE BEEN ISSUED TO THE INSURED NAMED ABOVE FOR THE POLICY PERIOD
INDICATED. NOTWITHSTANDING ANY REQUIREMENT, TERM OR CONDITION OF ANY CONTRACT OR OTHER DOCUMENT WITH RESPECT TO WHICH THIS
CERTIFICATE MAY BE ISSUED OR MAY PERTAIN, THE INSURANCE AFFORDED BY THE POLICIES DESCRIBED HEREIN 1S SUBJECT TO ALL THE TERMS,
EXCLUSIONS AND CONDITIONS OF SUCH POLICIES. LIMITS SHOWN MAY HAVE BEEN REDUCED BY PAID CLAIMS.

ADDLISUERT POLICY EFF | POLICY EXP
iy TYPE OF INSURANCE INSD | wvp | POLICY NUMBER {MM/CDAYYYY) | {MMIDDIYYYY) LIMITS
A | X | COMMERCIAL GENERAL LIABILITY ¥ ZLP1035945417 61142017 €1412018 | EACH OCCURRENCE 51,000,000
| DAMAGE TORENTED
| cuamsMaDeE | X | occur PREMISES {Ea ocourrence) | § 1.000,000
MED EXP {Any one parson) $ 10,000
PERSONAL & ADV INJURY | 5 1,000,000
GEN'L AGGREGATE LIMIT APPLIES PER GENERAL AGGREGATE $ 2.000.000
X | poLicy i Lac PRODUCTS - COMP/OP AGG | $ 2,000,000
OTHER: $
COMBINED STNGLE LIMIT
B | AUTOMOBILE LIABILITY Y BATBEOPO7S17 61412017 sraoms | GO e o
ANY AUTO BODILY INJURY {Per persen) | $
| ALL OWNED SCHEDULED 3
s i Y 1 B o]
X | wrepautos | X | 4on {Par accident) $
3
A | X | UMBRELLA LIAB X OCCUR Y ZUP10S5980A17 6142017 61142018 EACH OCCURRENCE $ 5.000.000
EXCESS LIAB CLAIMS-MADE AGGREGATE 3 5.000.000
pep | X | Retentionss 10000 $
C |WORKERS COMPENSATION UB3614M59317 61412017 en4ote | X | PER OTH-
AND EMPLOYERS' LIABILITY AR ER
ANY PROPRIETOR/PARTNER/EXECUTIVE EL EACH ACCIDENT $ 500 000
OFFICER/MEMBER EXCLUDED? NiA
{Mandatory in NH) E L DISEASE - EA EMPLOYEE; $ 500.000
If yas, describa under
DESCRIPTION OF OPERATIONS balow E L. DISEASE - POLICY LIMIT | § 500 000
A | Cyber Liabitty ZPL14REB02017 8/1412017 6142018 | Each Occumence $3 000.000
|
1

DESCRIPTION OF OPERATIONS / LOCATIONS / VEHICLES {ACORD 101, Additional Remarks Schadule, may be attached If more space is required)
Contract: 17-165-RFP ‘Electronic Health Record System’
The holder is included as additional insured on the General Liability and Umbrella Policies. 30 day natice of Cancellation applies

CERTIFICATE HOLDER

CANCELLATION

County Board of Arlington County, VA

SHOULD ANY OF THE ABOVE DESCRIBED POLICIES BE CANCELLED BEFORE
THE EXPIRATION DATE THEREOF, NOTICE WILL BE DELIVERED IN
ACCORDANCE WITH THE POLICY PROVISIONS.

AUTHORIZED REPRESENTATIVE

¢/o The Purchasing Agent 5
Clarendon Blvd.
Arlington VA 22201
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